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This manual describes the following R&S®FSV options:
● R&S FSV-K30 (1310.8355.02)

This manual describes the following R&S®FSV models with firmware version 2.20 and higher:
● R&S®FSV 4 (1321.3008K04)

● R&S®FSV 7 (1321.3008K07)

● R&S®FSV 13 (1321.3008K13)

● R&S®FSV 30 (1321.3008K30)

● R&S®FSV 40 (1321.3008K39)

● R&S®FSV 40 (1321.3008K40)

It also applies to the following R&S®FSV models. However, note the differences described in chapter 1.4,
"Notes for Users of R&S FSV 1307.9002Kxx Models", on page 9.
● R&S®FSV 3 (1307.9002K03)

● R&S®FSV 7 (1307.9002K07)

● R&S®FSV 13 (1307.9002K13)

● R&S®FSV 30 (1307.9002K30)

● R&S®FSV 40 (1307.9002K39)

● R&S®FSV 40 (1307.9002K40)

The firmware of the instrument makes use of several valuable open source software packages. For information, see the "Open
Source Acknowledgement" on the user documentation CD-ROM (included in delivery).
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.

© 2014 Rohde & Schwarz GmbH & Co. KG
Mühldorfstr. 15, 81671 München, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
E-mail: info@rohde-schwarz.com
Internet: www.rohde-schwarz.com
Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®FSV is abbreviated as R&S FSV.
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1 Preface

1.1 Documentation Overview

The user documentation for the R&S FSV is divided as follows:

● Quick Start Guide
● Operating Manuals for base unit and options
● Service Manual
● Online Help
● Release Notes

Quick Start Guide

This manual is delivered with the instrument in printed form and in PDF format on the
CD. It provides the information needed to set up and start working with the instrument.
Basic operations and basic measurements are described. Also a brief introduction to
remote control is given. The manual includes general information (e.g. Safety Instruc-
tions) and the following chapters:

Chapter 1 Introduction, General information

Chapter 2 Front and Rear Panel

Chapter 3 Preparing for Use

Chapter 4 Firmware Update and Installation of Firmware Options

Chapter 5 Basic Operations

Chapter 6 Basic Measurement Examples

Chapter 7 Brief Introduction to Remote Control

Appendix Printer Interface

Appendix LAN Interface

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

The Operating Manual for the base unit provides basic information on operating the
R&S FSV in general, and the "Spectrum" mode in particular. Furthermore, the software
options that enhance the basic functionality for various measurement modes are
described here. The set of measurement examples in the Quick Start Guide is expan-
ded by more advanced measurement examples. In addition to the brief introduction to
remote control in the Quick Start Guide, a description of the basic analyzer commands
and programming examples is given. Information on maintenance, instrument interfa-
ces and error messages is also provided.

 

 

Documentation Overview
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In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S FSV is not included in the
option manuals.

The following Operating Manuals are available for the R&S FSV:

● R&S FSV base unit; in addition:
– R&S FSV-K9 Power Sensor Support
– R&S FSV-K14 Spectrogram Measurement

● R&S FSV-K7 Analog Demodulation and R&S FSV-K7S FM Stereo Measurements
● R&S FSV-K10 GSM/EDGE Measurement
● R&S FSV-K30 Noise Figure Measurement
● R&S FSV-K40 Phase Noise Measurement
● R&S FSV-K70 Vector Signal Analysis Operating Manual

R&S FSV-K70 Vector Signal Analysis Getting Started (First measurements)
● R&S FSV-K72 3GPP FDD BTS Analysis
● R&S FSV-K73 3GPP FDD UE Analysis
● R&S FSV-K76/77 3GPP TD-SCDMA BTS/UE Measurement
● R&S FSV-K82/83 CDMA2000 BTS/MS Analysis
● R&S FSV-K84/85 1xEV-DO BTS/MS Analysis
● R&S FSV-K91 WLAN IEEE 802.11
● R&S FSV-K93 WiMAX IEEE 802.16 OFDM/OFDMA Analysis
● R&S FSV-K100/K104 EUTRA / LTE Downlink Measurement Application
● R&S FSV-K101/K105 EUTRA / LTE Uplink Measurement Application

These manuals are available in PDF format on the CD delivered with the instrument.

Service Manual

This manual is available in PDF format on the CD delivered with the instrument. It
describes how to check compliance with rated specifications, instrument function,
repair, troubleshooting and fault elimination. It contains all information required for
repairing the R&S FSV by replacing modules. The manual includes the following chap-
ters:

Chapter 1 Performance Test

Chapter 2 Adjustment

Chapter 3 Repair

Chapter 4 Software Update / Installing Options

Chapter 5 Documents

Online Help

The online help contains context-specific help on operating the R&S FSV and all avail-
able options. It describes both manual and remote operation. The online help is instal-

Documentation Overview
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led on the R&S FSV by default, and is also available as an executable .chm file on the
CD delivered with the instrument.

Release Notes

The release notes describe the installation of the firmware, new and modified func-
tions, eliminated problems, and last minute changes to the documentation. The corre-
sponding firmware version is indicated on the title page of the release notes. The cur-
rent release notes are provided in the Internet.

1.2 Conventions Used in the Documentation

1.2.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

1.2.2 Conventions for Procedure Descriptions

When describing how to operate the instrument, several alternative methods may be
available to perform the same task. In this case, the procedure using the touchscreen
is described. Any elements that can be activated by touching can also be clicked using
an additionally connected mouse. The alternative procedure using the keys on the
instrument or the on-screen keyboard is only described if it deviates from the standard
operating procedures.

The term "select" may refer to any of the described methods, i.e. using a finger on the
touchscreen, a mouse pointer in the display, or a key on the instrument or on a key-
board.

 

 

 

Conventions Used in the Documentation
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1.3 How to Use the Help System

Calling context-sensitive and general help

► To display the general help dialog box, press the HELP key on the front panel.

The help dialog box "View" tab is displayed. A topic containing information about
the current menu or the currently opened dialog box and its function is displayed.

For standard Windows dialog boxes (e.g. File Properties, Print dialog etc.), no context-
sensitive help is available.

► If the help is already displayed, press the softkey for which you want to display
help.

A topic containing information about the softkey and its function is displayed.

If a softkey opens a submenu and you press the softkey a second time, the submenu
of the softkey is displayed.

Contents of the help dialog box

The help dialog box contains four tabs:

● "Contents" - contains a table of help contents
● "View" - contains a specific help topic
● "Index" - contains index entries to search for help topics
● "Zoom" - contains zoom functions for the help display

To change between these tabs, press the tab on the touchscreen.

Navigating in the table of contents

● To move through the displayed contents entries, use the UP ARROW and DOWN
ARROW keys. Entries that contain further entries are marked with a plus sign.

● To display a help topic, press the ENTER key. The "View" tab with the correspond-
ing help topic is displayed.

● To change to the next tab, press the tab on the touchscreen.

Navigating in the help topics

● To scroll through a page, use the rotary knob or the UP ARROW and DOWN
ARROW keys.

● To jump to the linked topic, press the link text on the touchscreen.

Searching for a topic

1. Change to the "Index" tab.

 

How to Use the Help System
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2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Change the focus by pressing the ENTER key.

4. Select the suitable keyword by using the UP ARROW or DOWN ARROW keys or
the rotary knob.

5. Press the ENTER key to display the help topic.

The "View" tab with the corresponding help topic is displayed.

Changing the zoom

1. Change to the "Zoom" tab.

2. Set the zoom using the rotary knob. Four settings are available: 1-4. The smallest
size is selected by number 1, the largest size is selected by number 4.

Closing the help window

► Press the ESC key or a function key on the front panel.

1.4 Notes for Users of R&S FSV 1307.9002Kxx Models

Users of R&S FSV 1307.9002Kxx models should consider the following differences to
the description of the newer R&S FSV 1321.3008Kxx models:
● Functions that are based on the Windows7 operating system (e.g. printing or set-

ting up networks) may have a slightly different appearance or require different set-
tings on the Windows XP based models. For such functions, refer to the Windows
documentation or the documentation originally provided with the R&S FSV instru-
ment.

● The R&S FSV 1307.9002K03 model is restricted to a maximum frequency of
3 GHz, whereas the 1321.3008K04 model has a maximum frequency of 4 GHz.

● The bandwidth extension option R&S FSV-B160 (1311.2015.xx) is not available for
the R&S FSV 1307.9002Kxx models. The maximum usable I/Q analysis bandwidth
for these models is 28 MHz, or with option R&S FSV-B70, 40 MHz.

 

Notes for Users of R&S FSV 1307.9002Kxx Models
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2 Introduction to R&S FSV-K30 & Noise
Measurements
The use of an R&S FSV spectrum analyzer with its high sensitivity and level accuracy
enables the accurate and reproducible measurement of the noise figure of a Device
Under Test; for example, of low-noise FET amplifier circuits with noise figures of less
than 1 dB. Compared with specialist noise-measurement instruments, the properties of
the analyzer are ideal for noise measurements:

● Different configurations of the sweep number and sweep time for the level mea-
surement also allows the noise figure (and even the gain) of the DUT to be deter-
mined even at low frequencies.

● The high dynamic range of the analyzer enables measurements on highly amplify-
ing DUTs.

● The frequency range of the analyzer can be fully utilised as a measurement range.

R&S FSV-K30 makes full use of the features and accuracy of the spectrum analyzer to
provide accurate and flexible noise measurements that are very easy to use.

Overview of Firmware Option R&S FSV-K30

This section contains all information required for operation of an R&S FSV equipped
with Application Firmware R&S FSV-K30. It covers operation via menus and the
remote control commands for accurate and flexible noise measurement functions.

This section consists of the following chapters:

● Measurement Basics
Provides basic knowledge on performing noise measurements

● Measurement Examples (R&S FSV-K30)
Explains some basic noise figure measurement examples.

● Instrument Functions of Noise Figure Measurements (R&S FSV-K30)
Describes the instrument functions of noise figure measurements and provides fur-
ther information.

● Remote Control Commands
Describes all remote control commands defined noise figure measurements.

● Error Reporting and Error Messages
Contains device-specific error messages for R&S FSV-K30.

This part of the documentation includes only functions of the Application Firmware
R&S FSV-K30. For all other descriptions, please refer to the description of the base
unit at the beginning of the documentation.
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3 Measurement Basics
This section provides background information on measurements and displayed infor-
mation.

3.1 Measurement Types....................................................................................................11

3.2 Measurement Modes of the Noise Figure Measurement.........................................13

3.3 Measurement Settings Overview...............................................................................14

3.4 Result Displays........................................................................................................... 15

3.5 Status Bar Information............................................................................................... 18

3.6 Calibration................................................................................................................... 18

3.7 Selecting the Appropriate Filter Type....................................................................... 18

3.8 List of Available RRC and Channel Filters............................................................... 19

3.9 ASCII File Export Format............................................................................................21

3.10 Overview of Generators Supported by the R&S FSV.............................................. 22

3.1 Measurement Types

Three types of measurements are possible:

● Frequency list measurement
● Fixed frequency measurement
● Single frequency measurement

Frequency list measurement

A measurement is performed at each of the frequencies listed in the frequency list. The
noise figure of the DUT across a user-specified range of frequencies is measured. In
single sweep mode, each frequency point is measured once until the measurement is
complete. In continuous sweep mode, one frequency point after the other is measured
in turn until the measurement is aborted.

The frequency list is defined in the "Frequency Table" in the "Frequency Settings" dia-
log box (see "Frequency Settings" on page 43). Two methods are possible:

● The list is generated according to the start, stop and step frequencies. The first
value in the list is the "Start Freq". For each subsequent value, the "Step Freq" is
added until the "Stop Freq" is reached. If the "Stop Freq" is lower than the "Start
Freq", the "Step Freq" is subtracted from the "Start Freq" for each subsequent
value. A maximum of 100 list entries is generated. If further entries would be
required to reach the "Stop Freq", an error message is displayed. If the step fre-
quency is larger than the difference between the start frequency and the stop fre-
quency, the "Frequency Table" and the "Frequency List Results" (result display)
just contain the start and stop frequency.

 

 

Measurement Types
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● The list is generated according to the center frequency, span, and number of
sweep points. The number of "Sweep points" defines the number of entries in the
frequency table. The start frequency is "Center Freq" - "Span"/2, the stop fre-
quency is "Center Freq" + "Span"/2. The values inbetween are distributed evenly.
For Digital IQ mode, only this method can be used to define the frequency list.

The results are displayed in a table ( "Frequency List Results") or graphically, depend-
ing on the display configuration.

Remote commands:

To configure the frequency list:

[SENSe: ​]FREQuency: ​STARt​ on page 112

[SENSe: ​]FREQuency: ​STOP​ on page 112

[SENSe: ​]FREQuency: ​STEP ​ on page 112

or

[SENSe: ​]FREQuency: ​CENTer ​ on page 111

[SENSe: ​]FREQuency: ​SPAN ​ on page 112

[SENSe: ​]SWEep:​POINts ​ on page 113

To start the measurement:

CONFigure: ​LIST: ​CONTinuous ​ on page 87 or

CONFigure: ​LIST: ​SINGle​ on page 87

INIT
To query the results:

FETCh: ​ARRay:​NOISE: ​FIGure? ​ on page 96

FETCh: ​ARRay:​NOISE: ​GAIN? ​ on page 96

FETCh: ​ARRay:​NOISE: ​TEMPerature? ​ on page 96

Fixed frequency measurement

A continuous measurement is performed at the single frequency currently selected in
the "Frequency List Results" (see also Fix Freq softkey in the "Sweep" menu). This
measurement can only be performed after an initial frequency list or single frequency
measurement.

The results are displayed beneath the original "Frequency List Results" in the "Fixed
Frequency (Meter)" area.

Remote commands:

To configure the fixed frequency:

[SENSe:​]FREQuency[: ​CW|: ​FIXed] ​ on page 110

To start the measurement:

Measurement Types
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CONFigure: ​SINGle ​ on page 87

INIT
To query the results:

FETCh: ​SCALar:​NOISE: ​FIGure? ​ on page 97

FETCh: ​SCALar:​NOISE: ​GAIN? ​ on page 97

FETCh: ​SCALar:​NOISE: ​TEMPerature? ​ on page 97

Single frequency measurement

A measurement is performed at a specified single frequency, either once or continu-
ously. Thus, the individual frequency can be investigated in more detail, for example to
see the effect of dynamic changes to the noise figure of the DUT at a particular fre-
quency. An initial list measurement is not necessary.

The frequency is defined by activating the "Single Freq" option and entering the fre-
quency in the "Start Freq" field in the "Frequency Settings" dialog box (see "Frequency
Settings" on page 43). The "Frequency Table" is reduced to a single entry. In effect,
the single frequency measurement is a list measurement reduced to a single list entry.

The result of a fixed frequency measurement is displayed in the result table only, not
graphically.

Remote commands:

To configure the single frequency:

[SENSe: ​]FREQuency: ​STARt​ on page 112

To start the measurement:

CONFigure: ​FREQ:​CONTinuous ​ on page 86 or

CONFigure: ​FREQ:​SINGle ​ on page 86

INIT
To query the results:

FETCh: ​ARRay:​NOISE: ​FIGure?​ on page 96

FETCh: ​ARRay:​NOISE: ​GAIN?​ on page 96

FETCh: ​ARRay:​NOISE: ​TEMPerature? ​ on page 96

3.2 Measurement Modes of the Noise Figure Measure-
ment

Noise measurements are performed on many different types of device under test
(DUT). The type of DUT to be measured determines the test setup and also how the
frequency list is to be generated. To support these different types of DUT, the following
different noise figure measurement modes are available:

 

Measurement Modes of the Noise Figure Measurement
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● Direct measurement
● Frequency-converting measurement

– Fixed LO Upconverter, IF = RF + LO
– Fixed LO Downconverter, IF = abs(RF - LO)
– Fixed IF Upconverter, LO = abs(RF – IF)
– Fixed IF Downconverter, LO = RF + IF

● Digital IQ; for digital baseband input using the optional R&S FSV-B17 interface;
Using the Digital Baseband interface for input, the digital baseband signal from the
digital interface is used for measurement, rather than the digitalized IF signal.
In this mode, RF attenuation, a Preamplifier and calibration are not available. The
frequency list is defined by a center frequency, a span and a number of sweep
points (see "Frequency Settings" on page 43).
For details see the Digital Baseband Interface (R&S FSV-B17) description of the
base unit.

The setup for the different measurement types is described by the "Schematic Over-
view" softkey. The measurement mode is set in the "Frequency Settings" dialog box,
"Mode" field (see "Mode" on page 44).

For details on the measurement types see also chapter 4, "Measurement Examples
(R&S FSV-K30)", on page 25.

3.3 Measurement Settings Overview

The overall measurement settings used to obtain the current measurement results are
displayed in the diagram header at the top of the display (see figure 3-1). The following
settings are listed:

Setting Defined in dialog
box

Description

Auto Level Measurement Set-
tings

Enable/Disable automatic reference level

Ref Level Measurement Set-
tings

Set reference level

Full Scale Lvl. Measurement Set-
tings

Level that corresponds to an IQ sample with the magnitude "1"
(for digital input only)

Sample Rate Measurement Set-
tings

Input sample rate from the IQ signal source (for digital input
only)

Att Measurement Set-
tings

Set RF attenuation

Preamplifier Measurement Set-
tings

Enable/disable preamplifier

RBW Measurement Set-
tings

Set RBW

SWT Measurement Set-
tings

Set sweep time

 

Measurement Settings Overview
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Setting Defined in dialog
box

Description

AVG Measurement Set-
tings

Set number of measurement sweeps over which the average is
taken

Noise Source ENR Settings Set constant ENR or ENR table

Serial Nr. ENR Settings Reserved for serial number of the noise source (currently not
available)

ENR (Const) ENR Settings Set ENR value (dB), refers to the receive frequency (RF)

2nd Stage Corr Measurement Set-
tings

Enable/disable 2nd Stage Correction

Mode Frequency Settings Set measurement mode

Image Rej Frequency Settings Set suppression applied to the second sideband (Image Rej)

Fixed LO Frequency Settings Set Local oscillator frequency (Hz), only for frequency-convert-
ing measurements

Fixed IF Frequency Settings Set IF frequency for Fixed IF measurements

LO Source Frequency Settings External generator type controlling the LO (requires R&S FSV-
B10 option); only displayed when "Automatic Control" is
selected (see "Automatic Control" on page 52).

Fig. 3-1: Measurement settings for the noise figure measurements (example)

3.4 Result Displays

The measurement results are represented according to the measurement type (see
chapter 3.1, "Measurement Types", on page 11).

Frequency list results

The measurement results for all frequencies defined in the "Frequency Table" are dis-
played as a graph or a table, depending on the currently selected result display (see
"Display Graph/List" on page 62 softkey).

(See figure 3-3 and figure 3-2.)

The measurement results are updated as the measurement is in progress. Under "Cur-
rent Value", the details of the currently selected frequency in the "Frequency List
Results" are displayed.

 

Result Displays
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Fig. 3-2: Graphical result display (example)

Fig. 3-3: Result display table (example)

The following information is displayed in the table:

Result Displays
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Column Description

Used settings

RF Receive frequency at the DUT at which the values in this row of the table were mea-
sured (Hz).

LO Local oscillator frequency (Hz) - not displayed for direct or Digital IQ measurements

IF Intermediate frequency (Hz) - not displayed for direct or Digital IQ measurements

Results

NF Noise figure measured (dB)

Noise Temp Noise temperature (K) derived from measured noise figure

Gain Gain measured (dB); not available when using the Digital Baseband Interface
(R&S FSV-B17)

Fixed frequency results

Under "Fixed Frequency (Meter)", the measurement results for the fixed frequency
measurement are displayed and continuously updated (see also chapter 3.1, "Mea-
surement Types", on page 11). The "Frequency List Results" do not change - these are
the results of the last frequency list measurement.

During a running measurement, the "Fixed Frequency (Meter)" area displays the cur-
rent measurement value.

Result Displays
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3.5 Status Bar Information

The status bar displays the following information:

Parameter values If a parameter in a settings dialog box is selected, the minimum
and maximum values for the selected parameter are displayed.

 If a Boolean or an enumarated parameter in a dialog box is
selected, the minimum and maximum values are displayed as
N/A for not applicable.

Measurement status During the measurement, the current measurement status
along with detailed information about the progress is displayed.

Error messages red background

Warning messages yellow background

3.6 Calibration

The calibration measures the noise introduced to a signal by the spectrum analyzer
itself to compensate it in measurements on a device under test. This compensation is
called 2nd stage correction, because the spectrum analyzer is the second stage of the
test setup, the DUT being the first stage.

If the second stage correction is activated (see "2nd Stage Correction" on page 49),
a separate calibration measurement is performed before the main measurement (for
details on the measurement setup refer to the base unit Operating Manual on CD-
ROM, chapter "Advanced Measurement Examples"). The data measured in the cali-
bration measurement are used for compensation in the main measurement.

It is strongly recommended that you perform calibration before running measurements
(see "Cal" on page 59). You can run measurements in an uncalibrated status, but the
measurement results will not be corrected for any noise introduced by the spectrum
analyzer itself.

If the list of receive frequencies (RF) is changed, at which the measurements are per-
formed, calibration is necessary again to ensure that calibration data is available for
every measurement step. For details on frequency settings refer to "Frequency Set-
tings" on page 43.

Calibration data can be saved and recalled at any time via the SAVE/RCL key (for
details refer to the base unit description).

It is also included if "All Traces" are stored.

3.7 Selecting the Appropriate Filter Type

All resolution bandwidths are realized with digital filters.
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The video filters are responsible for smoothing the displayed trace. Using video band-
widths that are small compared to the resolution bandwidth, only the signal average is
displayed and noise peaks and pulsed signals are repressed. If pulsed signals are to
be measured, it is advisable to use a video bandwidth that is large compared to the
resolution bandwidth (VBW * 10 x RBW) for the amplitudes of pulses to be measured
correctly.

The following filter types are available:

● Normal (3dB) (Gaussian) filters
The Gaussian filters are set by default. The available bandwidths are specified in
the data sheet.

● CISPR (6 dB) filters
● MIL Std (6 dB) filters

Note that the 6 dB bandwidths are available only with option R&S FSV-K54.
● Channel filters

For details see chapter 3.8, "List of Available RRC and Channel Filters",
on page 19 .
Channel filters do not support FFT mode.

● RRC filters
For details see chapter 3.8, "List of Available RRC and Channel Filters",
on page 19 .
RRC filters do not support FFT mode.

● 5-Pole filters
The available bandwidths are specified in the data sheet.
5-Pole filters do not support FFT mode.

3.8 List of Available RRC and Channel Filters

For power measurement a number of especially steep-edged channel filters are availa-
ble (see the following table). The indicated filter bandwidth is the 3 dB bandwidth. For
RRC filters, the fixed roll-off factor (a) is also indicated.

Table 3-1: Filter types

Filter Bandwidth Filter Type Application

100 Hz CFILter  

200 Hz CFILter A0

300 Hz CFILter  

500 Hz CFILter  

 

1 kHz CFILter  

1.5 kHz CFILter  

2 kHz CFILter  

2.4 kHz CFILter SSB
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Filter Bandwidth Filter Type Application

2.7 kHz CFILter  

3 kHz CFILter  

3.4 kHz CFILter  

4 kHz CFILter DAB, Satellite

4.5 kHz CFILter  

5 kHz CFILter  

6 kHz CFILter  

6 kHz, a=0.2 RRC APCO

8.5 kHz CFILter ETS300 113 (12.5 kHz channels)

9 kHz CFILter AM Radio

 

10 kHz CFILter  

12.5 kHz CFILter CDMAone

14 kHz CFILter ETS300 113 (20 kHz channels)

15 kHz CFILter  

16 kHz CFILter ETS300 113 (25 kHz channels)

18 kHz, a=0.35 RRC TETRA

20 kHz CFILter  

21 kHz CFILter PDC

24.3 kHz, a=0.35 RRC IS 136

25 kHz CFILter  

30 kHz CFILter CDPD, CDMAone

50 kHz CFILter  

 

100 kHz CFILter  

150 kHz CFILter FM Radio

192 kHz CFILter PHS

200 kHz CFILter  

300 kHz CFILter  

500 kHz CFILter J.83 (8-VSB DVB, USA)

 

1 MHz CFILter CDMAone

1.228 MHz CFILter CDMAone

List of Available RRC and Channel Filters
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Filter Bandwidth Filter Type Application

1.28 MHz, a=0.22 RRC  

1.5 MHz CFILter DAB

2 MHz CFILter  

3 MHz CFILter  

3.75 MHz CFILter  

3.84 MHz, a=0.22 RRC W-CDMA 3GPP

4.096 MHz, a=0.22 RRC W-CDMA NTT DOCoMo

5 MHz CFILter  

20 MHz CFILter  

28 MHz CFILter  

40 MHz CFILter  

3.9 ASCII File Export Format

The data of the file header consist of three columns, each separated by a semicolon:
parameter name; numeric value; basic unit. The data section starts with the keyword
"Trace <n>" (<n> = number of stored trace), followed by the measured data in one or
several columns (depending on measurement) which are also separated by a semico-
lon.

File contents: header and data section Description

Type;FSV; Instrument model

Version;1.50; Firmware version

Date;01.Apr 2010; Date of data set storage

Screen;A; Instrument mode

Points per Symbol;4; Points per symbol

x Axis Start;-13;sym; Start value of the x axis

x Axis Stop;135;sym; Stop value of the x axis

Ref value y axis;-10.00;dBm; Y axis reference value

Ref value position;100;%; Y axis reference position

Trace;1; Trace number

Meas;Result; Result type

Meas Signal;Magnitude; Result display

Demodulator;Offset QPSK; Demodulation type

ResultMode;Trace; Result mode
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File contents: header and data section Description

x unit;sym; Unit of the x axis

y unit;dBm; Unit of the y axis

Trace Mode;Clear Write; Trace mode

Values;592; Number of results

<values> List of results

3.10 Overview of Generators Supported by the R&S FSV

The R&S SMA and R&S SMU require the following firmware versions:
R&S SMA: V2.10.x or higher
R&S SMU: V1.10 or higher

Generator Interface Type Generator Min
Freq

Generator Max
Freq

Generator Min
Power

dBm

Generator Max
Power

dBm

SMA01A TTL 9 kHz 3.0 GHz -145 +30

SMBV100A3 TTL 9 kHz 3.2 GHz -145 +30

SMBV100A6 TTL 9 kHz 6.0 GHz -145 +30

SMC100A1 TTL 9 kHz 1.1 GHz -120 +30

SMC100A3 TTL 9 kHz 3.2 GHz -145 +30

SME02 TTL 5 kHz 1.5 GHz -144 +16

SME03 TTL 5 kHz 3.0 GHz -144 +16

SME06 TTL 5 kHz 6.0 GHz -144 +16

SMG GPIB 100 kHz 1.0 GHz -137 +13

SMGL GPIB 9 kHz 1.0 GHz -118 +30

SMGU GPIB 100 kHz 2.16 GHz -140 +13

SMH GPIB 100 kHz 2.0 GHz -140 +13

SMHU GPIB 100 kHz 4.32 GHz -140 +13

SMIQ02B TTL 300 kHz 2.2 GHz -144 +13

SMIQ02E GPIB 300 kHz 2.2 GHz -144 +13

SMIQ03B TTL 300 kHz 3.3 GHz -144 +13

SMIQ03E GPIB 300 kHz 3.3 GHz -144 +13

SMIQ04B TTL 300 kHz 4.4 GHz -144 +10
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Generator Interface Type Generator Min
Freq

Generator Max
Freq

Generator Min
Power

dBm

Generator Max
Power

dBm

SMIQ06B TTL 300 kHz 6.4 GHz -144 +10

SML01 GPIB 9 kHz 1.1 GHz -140 +13

SML02 GPIB 9 kHz 2.2 GHz -140 +13

SML03 GPIB 9 kHz 3.3 GHz -140 +13

SMR20 TTL 1 GHz 20 GHz -130 2) +11 2)

SMR20B111) TTL 10 MHz 20 GHz -130 2) +13 2)

SMR27 TTL 1 GHz 27 GHz -130 2) +11 2)

SMR27B11 1) TTL 10 MHz 27 GHz -130 2) +12 2)

SMR30 TTL 1 GHz 30 GHz -130 2) +11 2)

SMR30B11 1) TTL 10 MHz 30 GHz -130 2) +12 2)

SMR40 TTL 1 GHz 40 GHz -130 2) +9 2)

SMR40B11 1) TTL 10 MHz 40 GHz -130 2) +12 2)

SMR50 TTL 1 GHz 50 GHz -130 2) +9 2)

SMR50B11 1) TTL 10 MHz 50 GHz -130 2) +12 2)

SMR60 TTL 1 GHz 60 GHz -130 2) +9 2)

SMR60B11 1) TTL 10 MHz 60 GHz -130 2) +12 2)

SMP02 TTL 10 MHz 20 GHz -130 3) +17 3)

SMP03 TTL 10 MHz 27 GHz -130 3) +13 3)

SMP04 TTL 10 MHz 40 GHz -130 3) +12 3)

SMP22 TTL 10 MHz 20 GHz -130 3) +20 3)

SMT02 GPIB 5.0 kHz 1.5 GHz -144 +13

SMT03 GPIB 5.0 kHz 3.0 GHz -144 +13

SMT06 GPIB 5.0 kHz 6.0 GHz -144 +13

SMV03 GPIB 9 kHz 3.3 GHz -140 +13

SMU200A TTL 100 kHz 2.2 GHz -145 +13

SMU02B31 TTL 100 kHz 2.2 GHz -145 +19

SMU03 TTL 100 kHz 3 GHz -145 +13

SMU03B31 TTL 100 kHz 3 GHz -145 +19

SMU04 TTL 100 kHz 4 GHz -145 +13

SMU04B31 TTL 100 kHz 4 GHz -145 +19

SMU06 TTL 100 kHz 6 GHz -145 +13

SMU06B31 TTL 100 kHz 6 GHz -145 +19

Overview of Generators Supported by the R&S FSV
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Generator Interface Type Generator Min
Freq

Generator Max
Freq

Generator Min
Power

dBm

Generator Max
Power

dBm

SMX GPIB 100 kHz 1.0 GHz -137 +13

SMY01 GPIB 9 kHz 1.04 GHz -140 +13

SMY02 GPIB 9 kHz 2.08 GHz -140 +13

HP8340A GPIB 10 MHz 26.5 GHz -110 10

HP8648 GPIB 9 kHz 4 GHz -136 10

HP ESG-A Ser-
ies 1000A,
2000A, 3000A,
4000A

GPIB 250 kHz 4 GHz -136 20

HP ESG-D
SERIES
E4432B

GPIB 250 kHz 3 GHz -136 +10

1) Requires the option SMR-B11 to be fitted.

2) Maximum/minimum power depends on presence of Option SMR-B15/-B17 and set
frequency range. For more details see SMR data sheet.

3) Maximum/minimum power depends on presence of Option SMP-B15/-B17 and set
frequency range. For more details see SMP data sheet.

Overview of Generators Supported by the R&S FSV
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4 Measurement Examples (R&S FSV-K30)
This section describes measurement examples for the Noise Figure Measurements
option (K30). For further information on measurement examples refer to the Quick
Start Guide, chapter "Basic Measurement Examples", or the Operating Manual on CD.

This chapter provides the following measurement examples:

4.1 Direct Measurements..................................................................................................25

4.1.1 Basic Measurement Example....................................................................................... 25

4.1.2 DUTs with very Large Gain........................................................................................... 28

4.2 Frequency-Converting Measurements......................................................................28

4.2.1 Fixed LO Measurements...............................................................................................29

4.2.2 Image-Frequency Rejection (SSB, DSB)...................................................................... 29

4.2.3 Fixed IF Measurements................................................................................................ 32

4.1 Direct Measurements

Direct measurements are designed for DUTs without frequency-conversion, e.g. ampli-
fiers.

● chapter 4.1.1, "Basic Measurement Example", on page 25
● chapter 4.1.2, "DUTs with very Large Gain", on page 28

4.1.1 Basic Measurement Example

This section provides step-by-step instructions for working through an ordinary noise
figure measurement. The following steps are described:

● "Setting up the measurement" on page 25
● "Performing the calibration" on page 27
● "Performing the main measurement" on page 27

The gain and noise figure of an amplifier are to be determined in the range from 220
MHz to 320 MHz.

Setting up the measurement

1. Activate the "Noise" mode by pressing the MODE key and selecting "Noise".

2. Press the "Freq Settings" softkey to open the "Frequency Settings" dialog box.
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3. In the "Start Freq" field, enter 550 MHz.

4. In the "Stop Freq" field, enter 560 MHz.

5. In the "Step Freq" field, enter 2 MHz.

A measurement at 6 frequency points is performed: 550 MHz, 552 MHz, 554 MHz,
…, 560 MHz.

6. Press the "ENR Settings" softkey to open the "ENR" dialog box.

7. In the "ENR Constant" field, enter the average ENR value of the used noise source
for the frequency range of interest, for example 15 dB.

8. Press the "Meas Settings" softkey to open the "Measurement Settings" dialog box.

Direct Measurements
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9. If it is not yet active, activate the "2nd Stage Correction" option to perform the mea-
surement as accurately as possible.

Performing the calibration

1. Connect the noise source to the RF input of the R&S FSV (see figure 4-1).

2. Provide the voltage supply for the noise source by connecting it to the +28 V con-
nector of the R&S FSV (labeled "NOISE SOURCE CONTROL" on the front panel
of the instrument) via a coax cable.

Fig. 4-1: Preparation for calibration

3. Start the calibration for the "Noise Figure Measurements" option.

a) Press the SWEEP key.
b) Press the "Cal" softkey.

The progress bar indicates the progress of the calibration measurement.

Performing the main measurement

1. Insert the DUT (in this example, the amplifier) into the test setup between the noise
source and RF input of the R&S FSV (see figure 4-2).

Fig. 4-2: Test setup for the main measurement

2. To select the sweep mode, press the SWEEP key.

3. Press the RUN SINGLE key to start a single measurement.

Direct Measurements
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Measurement results are updated as the measurement is in progress. The results
are displayed in graphical form. There are two traces, one for noise figure/tempera-
ture and one for the gain of the DUT.

4. To change the display from the graphical form to a tabular list of measurement
points, press the "Display List/Graph" softkey in the "Trace" menu.

Note:
If a measurement is started while another measurement is still in progress, the first
measurement is aborted and the new measurement started immediately.

4.1.2 DUTs with very Large Gain

If the gain of the DUT exceeds 60 dB, the total gain must be reduced by an external
attenuator. The total gain of the DUT together with the external attenuator should lie
within the range from 10 dB to 60 dB. A total gain of 20 dB to 30 dB is recommended.
For a DUT with a gain of e.g. 64 dB, it is recommended to use an external 40 dB-
attenuator.

If an external attenuator is used, in the "Measurement Settings" dialog box, the entry in
the "Range" field should be modified according to the total gain (= Gain DUT â€“ exter-
nal attenuator).

The attenuation values of the external attenuator are entered in the "Loss Settings"
dialog box under "Loss Output Settings".

Inaccuracies when entering this attenuation mainly influence the measured gain. The
noise figure remains to a large extent unaffected.

Fig. 4-3: Calibration and measurement on DUTs with a high gain

4.2 Frequency-Converting Measurements

The frequency-converting measurement is used for DUTs with an output frequency
that differs from the input frequency, e.g. mixers and frequency converters. The fre-
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quency-converting measurement allows many variations, which differ from each other
in two criteria:

● chapter 4.2.1, "Fixed LO Measurements", on page 29
● chapter 4.2.2, "Image-Frequency Rejection (SSB, DSB)", on page 29

4.2.1 Fixed LO Measurements

In the "Frequency Settings" dialog box, select one of the following settings for the
"Mode" parameter:

● Fixed LO, Up Conv, for up-converting devices with IF=RF+LO
● Fixed LO, Down Conv, for down converters with IF=abs(RF-LO) or image meas-

urements

4.2.2 Image-Frequency Rejection (SSB, DSB)

Test Setup

► Set the following parameters:

a) "IF" (intermediate frequency): 100 MHz
b) "RF" (input frequency): 400 MHz
c) "LO" (local oscillator frequency): 500 MHz
d) "image" (image frequency): 600 MHz

If a DUT, which equally converts the useful signal and the image to the IF frequency, is
measured using the conventional y factor method or with the 2nd stage correction
switched on, a measuring error of 3 dB is produced. The noise figure is displayed 3 dB
lower and the gain 3 dB higher. The following examples help to configure the test setup
in order to measure the actual values.
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4.2.2.1 Measurement on a single-sideband mixer

In general, a single-sideband mixer with a very high image rejection causes very few
problems. The measurement is analogous to an amplifier. In this case, set the image
rejection in the "Frequency Settings" dialog box to a large value (e.g. 999.99 dB).

4.2.2.2 Measurement on a mixer without sideband suppression

If the input and image frequencies are converted with the same application, an error of
3 dB occurs in the measurement results if the image rejection is not taken into account.
In this case, set the image rejection in the "Frequency Settings" dialog box to a small
value (e.g. 0.0 dB).

4.2.2.3 Measurement on a mixer with an average sideband suppression

For measurements on a mixer with a low image-frequency rejection, a measuring error
of 0 to 3 dB is obtained if the image-frequency rejection is not taken into account. In
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this case, set the image rejection in the "Frequency Settings" dialog box to the correct
image rejection value to produce the correct results.

4.2.2.4 Measurement on a mixer with unknown sideband suppression

If the image rejection is not known, accurate noise results can still be produced. How-
ever, the gain of the DUT must be known and an additional filter is required.

Test setup

Fig. 4-4: Preparation for calibration

Fig. 4-5: Test setup for the main measurement

In this test setup, a low pass filter prevents noise from the noise source from being fed
in at the image frequency. Depending on the position of the frequency bands, a high-
pass or bandpass filter may also be necessary for the RF frequency instead of the low-
pass filter. The important point is that noise from the noise source is not converted by a
further receive path of the mixer. The noise of the noise source at the receive fre-
quency must not be reduced. The insertion loss must be considered, if applicable.

With this test setup, the measurement on a mixer without sideband suppression corre-
sponds to the measurement on a single-sideband mixer. As in that case, set the image
rejection in the "Frequency Settings" dialog box to a large value (e.g. 999.99 dB) to
produce accurate results.

To take the characteristics of the filter into account, in the "Loss Settings" dialog box,
enter the insertion loss of the filter at the RF frequency. To consider the actual filter
suppression at the image frequency, do not enter 999 dB but the actual attenuation for
the image rejection.
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4.2.2.5 Measurement on a harmonics mixer

For a harmonics mixer, the input signals are not only converted to the IF by the wanted
harmonic, but also by the harmonic of the LO signal produced in the mixer. In many
cases, the mixer even features a lower conversion loss in the case of unwanted har-
monics. For measurements on this type of mixer, a bandpass filter must be used to
make sure that that there is only noise at the desired input frequency at the input of the
DUT. This measurement is similar to measurements on a mixer with an average side-
band suppression.

4.2.3 Fixed IF Measurements

During a "Fixed IF" measurement, a mixer can be tested using an R&S FSV at a fixed
frequency, while the Local Oscillator frequency of a connected external generator
sweeps the frequency list. The LO frequency is controlled by the R&S FSV-K30 option,
which drives the external generator using the R&S FSV-B10 option.

Thus, this measurement requires an R&S FSV with the K30 and B10 options installed.

Tracking generator vs. external generator
In Spectrum mode, when using the B10 option, the frequencies of the analyzer and the
generator are coupled by default. The generator is thus referred to as a "tracking gen-
erator". In Noise Measurements mode, on the other hand, the analyzer uses a fixed
frequency while the generator sweeps the frequency list. The generator is thus simply
referred to as an "external generator".

The Fixed IF measurement can calculate frequencies for downconverter or
upconverter devices. For downconverter devices, the LO is set according to the for-
mula:

LO = RF + IF

For upconverter devices, the LO is set according to the formula:

LO = abs(RF-IF)

The generator frequency actually used during the measurement is calculated by the
R&S FSV-K30 option based on the LO frequencies in the frequency list. The following
formula is used to calculate the generator frequency:

Generator Frequency = [(LO + Offset 1) * Factor 1 / Factor 2)] + Offset 2

The offset values and factors for the calculation are defined in the "Measurement Set-
tings". If changes are made to the settings, the start and stop frequencies of the exter-
nal generator are calculated and displayed.

Measurement results

The measurement results can be displayed against the RF or LO frequencies, depend-
ing on the x-axis selection in the "Display Settings" (see "X-Axis" on page 58).
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To set up a Fixed IF measurement

As opposed to the Spectrum mode, the Noise measurement mode does not provide a
separate dialog box for setting up the generator. The settings are contained in the gen-
eral "Frequency Settings" and "Measurement Settings" dialog boxes if the R&S FSV-
B10 option is installed. For details on the settings see "Frequency Settings"
on page 43 and "Meas Settings" on page 48.

1. Connect the external generator to the R&S FSV-B10 interface on the R&S FSV's
rear panel.

2. In Noise measurement mode, press the "Frequency Settings" softkey to display the
"Frequency Settings" dialog box.

3. In the "Frequency Settings" dialog box, select the "Mode" Fixed IF, Up Conv to test
an upconverting mixer.

4. In the "Fixed IF" field, enter 1000000000.

5. In the Frequency Table, define the LO frequencies for the external generator.
Which frequencies the generator actually uses during the measurement is calcula-
ted according to the offset values and factors specified in Generator Settings/ Gen-
erator Frequency.

6. Press the "Meas Settings" softkey to open the "Measurement Settings" dialog box.
Define the settings for the external generator as shown in the screenshot below
and described in "Generator Settings/ Generator Frequency" on page 52.

Frequency-Converting Measurements
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7. Press the "Display Settings" softkey to open the "Graphic" dialog box.

8. In the "Noise and Gain X-Axis Settings", select RF or LO as the frequency to be
displayed on the "X-Axis".

9. Press the RUN SINGLE or RUN CONT hardkey on the front panel to start a mea-
surement.

The measurement is performed. The results for each frequency in the frequency
list are displayed in the diagram and the result table.

Frequency-Converting Measurements
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Fig. 4-6: Fixed IF measurement results displayed against RF frequencies

Frequency-Converting Measurements
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Frequency-Converting Measurements
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5 Instrument Functions of Noise Figure Meas-
urements (R&S FSV-K30)
The "Noise Figure Measurements" option provides noise figure measurements. Using
this option, the noise figure of a Device Under Test, e.g. low-noise amplifier circuits,
with noise figures of less than 1 dB can be measured.

To open the main noise figure measurements menu

● If the "Noise" mode is not the active measurement mode, press the MODE key and
activate the "Noise" option.

● If the "Noise" mode is already active, press the HOME key.
The main noise figure measurements menu is displayed.

Menu and softkey description

chapter 6, "Menu and Softkey Description (R&S FSV-K30)", on page 39

Tasks

● chapter 5.1, "Editing Tables", on page 37
● chapter 5.2, "Working With Limit Lines", on page 37

5.1 Editing Tables

1. Select the table header to enter into the edit mode.

2. Focus the field you want to edit by touching it or using the arrow keys or the rotary
knob.

3. Enter the values (for details refer to the Quick Start Guide, chapter 4, "Basic Oper-
ations").

4. To insert a new row above the currently selected row, press the "Insert" softkey.

a) To delete the currently selected row, press the "Delete" softkey.
b) To update the "Frequency Table" according to the "Frequency Settings", press

the "Build Tbl" softkey.

5. Press the "Exit" softkey to leave the edit mode.

5.2 Working With Limit Lines

1. Press the LINES key.
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The "Limit Lines" dialog box is displayed. It contains information on name, limit,
status, and a comment.

2. To activate limit lines, select the limit line you want to activate and press the
"Enable/Disable" softkey.

3. To define a new limit line, press the "New" softkey and enter the limit line charac-
teristics.

4. To modify a limit line, select the limit line you want to edit and press the "Edit" soft-
key.

5. To save a limit line, press the "Exit" softkey.
If data is missing or if some data is invalid, an error message is displayed.

6. To delete a limit line, select the limit line you want to edit and press the "Delete"
softkey.

Working With Limit Lines
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6 Menu and Softkey Description (R&S FSV-
K30)
In the following sections the softkeys available in the noise figure measurements are
explained.

The "Auto Set", "Trigger", "Meas Config" and "Marker Functions" menus are not availa-
ble for noise figure measurements.

6.1 Softkeys and Settings of the Noise Menu (R&S FSV-K30)......................................39

6.2 Softkeys of the Frequency Menu (R&S FSV-K30).................................................... 59

6.3 Softkeys of the Span Menu (R&S FSV-K30)............................................................. 60

6.4 AMPT key..................................................................................................................... 61

6.5 BW key......................................................................................................................... 61

6.6 Softkeys of the Sweep Menu (R&S FSV-K30)...........................................................61

6.7 Softkeys of the Trace Menu (R&S FSV-K30).............................................................62

6.8 Softkeys of the Marker Menu (R&S FSV-K30).......................................................... 63

6.9 Softkeys of the Marker To Menu (R&S FSV-K30)..................................................... 64

6.10 Softkeys of the Lines Menu (R&S FSV-K30).............................................................65

6.11 Softkeys of the Input/Output Menu (R&S FSV-K30).................................................67

6.1 Softkeys and Settings of the Noise Menu (R&S FSV-
K30)

The following table shows all softkeys available in the noise figure measurements
("Noise") menu.

Schematic Overview..................................................................................................... 41
Frequency Settings....................................................................................................... 43

└ Frequency Settings.........................................................................................43
└ Single Freq........................................................................................... 43
└ Start Freq..............................................................................................43
└ Stop Freq..............................................................................................43
└ Step Freq..............................................................................................44
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Schematic Overview
Displays the schematic diagram of the test setup for the selected measurement type
and the specified frequency ranges. If the frequency ranges are changed, the sche-
matic diagram is updated accordingly. The test setup varies depending on the mea-
surement mode:

● Direct measurement
The direct measurement mode is designed for DUTs without frequency-conversion,
e.g. amplifiers.
The schematic display for the direct measurement mode is shown in figure 6-1.
The upper part of the figure shows the setup for calibration. The lower part of the
figure shows the test setup for the measurement.

Fig. 6-1: Schematic diagram for direct measurements
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● Frequency-converting measurement
The frequency-converting measurement mode is designed for frequency-convert-
ing DUTs that have a fixed Local Oscillator (LO) frequency, for example, satellite
converters with a fixed LO frequency.
The schematic display for the frequency-converting measurement mode is shown
in figure 6-2. The upper part of the figure shows the setup for calibration. The lower
part of the figure shows the test setup for the measurement.

Fig. 6-2: Schematic diagram for frequency converting measurements

Note: The schematic overview now provides direct access to the most important con-
figuration steps. Select the step for the setting you want to edit to display the corre-
sponding dialog box.

Configuration step Dialog box

Noise Source "ENR Settings" on page 46

Spectrum Analyzer "Meas Settings" on page 48

Loss Input "Loss Settings" on page 47

Loss Output "Loss Settings" on page 47

DUT "Frequency Settings" on page 43

Local Oscillator "Meas Settings" on page 48
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Frequency Settings
Opens the "Frequency Settings" dialog box.

Frequency Settings ← Frequency Settings
Under "Frequency Settings", the frequency settings and the measurement mode are
set.

Single Freq ← Frequency Settings ← Frequency Settings
Activates a single frequency measurement. Instead of measuring a list of frequencies,
a single frequency is measured once or continuously. The frequency to be measured is
defined in the Start Freq field.

Remote command: 
CONFigure: ​FREQ: ​CONTinuous ​ on page 86
CONFigure: ​FREQ: ​SINGle​ on page 86

Start Freq ← Frequency Settings ← Frequency Settings
Specifies the start frequency. This is the first receive frequency (RF) entry in the "Fre-
quency Table" and the "Frequency List Results" (result display). For single frequency
measurements, the start frequency defines the single frequency to be measured.

If the start frequency is changed, the "Frequency Table" is updated accordingly. For
details see chapter 3.1, "Measurement Types", on page 11.

Remote command: 
[SENSe: ​]FREQuency: ​STARt​ on page 112

Stop Freq ← Frequency Settings ← Frequency Settings
Specifies the stop frequency. This is the last receive frequency (RF) entry in the "Fre-
quency Table" and the "Frequency List Results" (result display).

If the stop frequency is changed, the "Frequency Table" is updated accordingly.

Remote command: 
[SENSe: ​]FREQuency: ​STOP ​ on page 112
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Step Freq ← Frequency Settings ← Frequency Settings
Specifies the step size between the single measurement steps (i.e. entries in the fre-
quency table). If the step frequency is larger than the difference between the start fre-
quency and the stop frequency, the "Frequency Table" and the "Frequency List
Results" (result display) just contain the start and stop frequency. For details see chap-
ter 3.1, "Measurement Types", on page 11.

If the step frequency is changed, the "Frequency Table" is updated accordingly.

Remote command: 
[SENSe:​]FREQuency: ​STEP​ on page 112

Center Freq ← Frequency Settings ← Frequency Settings
Defines the center frequency.

Remote command: 
[SENSe: ​]FREQuency: ​CENTer ​ on page 111

Span ← Frequency Settings ← Frequency Settings
Specifies the frequency span.

Remote command: 
[SENSe:​]FREQuency: ​SPAN ​ on page 112

Sweep points ← Frequency Settings ← Frequency Settings
Defines the number of measured values to be collected during one sweep.

Remote command: 
[SENSe: ​]SWEep: ​POINts​ on page 113

Mode ← Frequency Settings ← Frequency Settings
Specifies the measurement mode. For details on modes refer to chapter 3.2, "Mea-
surement Modes of the Noise Figure Measurement", on page 13.

If the mode is changed, the "Frequency Table" is updated accordingly.

"Direct" Direct measurement

"Fixed LO
Upconverter"

IF = RF + LO

"Fixed LO
Down-
converter"

IF = |(RF - LO)|

"Digital IQ" Digital baseband input using the optional R&S FSV-B17 interface

"Fixed LO
Upconverter"

LO = abs(RF – IF)
Requires R&S FSV-B10 option
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"Fixed IF
Down-
converter"

LO = RF + IF
Requires R&S FSV-B10 option

Remote command: 
[SENSe: ​]CONFigure: ​MODE:​DUT ​ on page 108
To select the type of DUT
[SENSe: ​]CONFigure: ​MODE:​SYSTem: ​LOSCillator ​ on page 109
To select Fixed LO or Fixed IF.

Fixed LO ← Frequency Settings ← Frequency Settings
Specifies the fixed local oscillator frequency. This field is only available if a frequency-
converting measurement mode is selected ("Mode" field). For details on modes refer to
chapter 3.2, "Measurement Modes of the Noise Figure Measurement", on page 13.

If the fixed LO is changed, the "Frequency Table" is updated accordingly.

Remote command: 
[SENSe:​]CONFigure: ​MODE: ​SYSTem: ​LOSCillator: ​FREQuency ​ on page 110

Fixed IF ← Frequency Settings ← Frequency Settings
Specifies the fixed IF frequency. This field is only available if a "Fixed IF" measurement
mode is selected ("Mode" field). For details see chapter 4.2.3, "Fixed IF Measure-
ments", on page 32.

If the fixed IF is changed, the "Frequency Table" is updated accordingly.

Remote command: 
[SENSe: ​]CONFigure: ​MODE:​SYSTem: ​IF:​FREQuency ​ on page 109

Image Rej ← Frequency Settings ← Frequency Settings
Specifies the suppression applied to the second sideband. This field is only available if
a frequency-converting measurement mode is selected. For details on modes refer to
chapter 3.2, "Measurement Modes of the Noise Figure Measurement", on page 13.

The value entered is applied across the complete frequency range. A value of 999.99
dB corresponds to the generally used single-sideband measurement (SSB), where the
second sideband does not noticeably affect the measurement result. This is the default
value. A value of 0 dB corresponds to the double-sideband measurement (DSB),
where both sidebands are converted to the same extent.

Remote command: 
[SENSe: ​]CORRection: ​IREJection ​ on page 103

Frequency Table ← Frequency Settings
Under "Frequency Table", the individual measurement steps are listed that will be per-
formed exactly in the order of the table. They are generated from the start frequency,
the stop frequency, and the step size on basis of the selected mode. If the start fre-
quency is smaller than the stop frequency, the RF values are generated into a list of
ascending frequencies. If the start frequency is larger, the list is descending. No more
than 100 measurement steps are possible. If the gap between start and stop frequency
is too large, increase the step frequency.

Depending on the measurement type, the "Frequency Table" contains the following
columns:
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Measurement type Column Description

Direct measurement RF Receive frequency, generated from the "Start Freq", the "Stop
Freq", and the "Step Freq" field entries

Frequency-converting
measurement

LO Constant LO frequency, defined via the "Fixed LO" field

Frequency-converting
measurement

IF IF frequency, calculated according to the "Mode" field

 Image Image frequency, shows whether image frequency filters are
required and for which frequency range the image rejection of
the DUT is needed ("Image Rej" field)

You can customize the "Frequency Table" by editing, deleting, and inserting measure-
ment steps. This is useful in order to insert extra measurement steps near a specific
frequency of interest in order to get more detailed results. If the start, stop, or step fre-
quency is changed, the "Frequency Table" is generated afresh and all manual modifi-
cations are overwritten. To customize this table, proceed according to chapter 5.1,
"Editing Tables", on page 37.

Remote command: 
[SENSe: ​]FREQuency: ​LIST: ​DATA ​ on page 111

ENR Settings
Opens the "ENR" dialog box.

The abbreviation ENR stands for "excess noise ratio". Correct ENR values for the
noise source are essential to perform accurate measurements. They are used to calcu-
late the effective noise temperature of the noise source that in turn is used for calcula-
tion of measurement results.

Remote command: 
[SENSe: ​]CORRection: ​ENR[:​MEASurement]: ​TABLe:​DATA ​ on page 103

Selection ← ENR Settings
Defines the used ENR values. The default ENR value is 15 dB as a constant value that
is valid for all frequencies.

"Constant" The value specified in the "ENR Constant" field is used for all fre-
quencies (see "ENR Constant" on page 47). The entries of the
"ENR Table" are ignored.
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"Table" The entries of the "ENR Table" provide the basis for the ENR values.
Between these values the R&S FSV uses interpolated values.

Remote command: 
[SENSe: ​]CORRection: ​ENR:​SPOT ​ on page 103

ENR Constant ← ENR Settings
Specifies the constant ENR value of the noise source that is used throughout the entire
frequency range. This parameter is only editable if "Constant" is selected in the selec-
tion list.

Remote command: 
[SENSe: ​]CORRection: ​ENR:​SPOT ​ on page 103

Room Temperature ← ENR Settings
Specifies the current room temperature as an absolute value in Kelvin. This value is
used in the calculation of the noise results.

Remote command: 
[SENSe:​]CORRection: ​TEMPerature ​ on page 107

ENR Table ← ENR Settings
Under "ENR Table", the frequency-dependent ENR values are listed. The list can con-
tain up to 100 RF/ENR pairs. The order of the RF values in the list is not important. To
modify this table, proceed as described in chapter 5, "Instrument Functions of Noise
Figure Measurements (R&S FSV-K30)", on page 37.

ENR tables can be saved and recalled at any time via the SAVE/RCL key (for details
refer to the base unit description).

In addition to the data saved by the basic unit, all data entered in the "ENR Settings"
dialog box is saved.

Loss Settings
Opens the "LOSS" dialog box to take additional losses due to cables or attenuators
into account that are not considered in the calibration.

The loss Settings dialog box contains the following elements:

Loss Input Settings
Under "Loss Input Settings", the additional loss between the noise source and the DUT
is defined.

Loss Output Settings
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Under "Loss Output Settings", the additional loss between the DUT and the analyzer is
defined.

Loss settings can be saved and recalled at any time via the SAVE/RCL key (for details
refer to the base unit description).

In addition to the data saved by the basic unit, all data entered in the "Loss Settings"
dialog box is saved.

Remote command: 
[SENSe:​]CORRection: ​LOSS:​INPut: ​TABLe​ on page 105
[SENSe: ​]CORRection: ​LOSS:​OUTPut: ​TABLe​ on page 106

Selection ← Loss Settings
Defines the used Loss values.

"Constant" The values specified in the "Loss Input Constant"/"Loss Output Con-
stant" fields are used for all frequencies. The entries of the "Loss
Input/Output" table are ignored.

"Table" The entries of the "Loss Input/Output" table provide the basis for the
"Loss" values. Between these values the R&S FSV uses interpolated
values.

Remote command: 
[SENSe: ​]CORRection: ​LOSS:​INPut: ​MODE​ on page 104
[SENSe: ​]CORRection: ​LOSS: ​INPut: ​TABLe​ on page 105

Loss Input Constant/Loss Output Constant ← Loss Settings
Specifies the constant loss value that is used across the entire frequency range. This
parameter is only editable if "Constant" is selected in the selection list.

Remote command: 
[SENSe:​]CORRection: ​LOSS:​INPut: ​SPOT​ on page 104
[SENSe:​]CORRection: ​LOSS:​OUTPut: ​SPOT​ on page 106

Loss Input Table/ Loss Output Table ← Loss Settings
Under "Loss Input Table" or "Loss Output Table", the list can contain up to 100
RF/ENR pairs. The order of the RF values in the list is not important. To modify this
table, proceed as described in chapter 5, "Instrument Functions of Noise Figure Meas-
urements (R&S FSV-K30)", on page 37.

Loss tables can be saved and recalled at any time via the FILE key (for details refer to
the base unit description). In addition to the data saved by the basic unit, all loss input
& output data entered in the loss settings dialog box is saved.

Meas Settings
Opens the "Measurement Settings" dialog box to modify all settings related to the over-
all measurement.

Alternatively, the "Measurement Settings" dialog box is opened as follows:

● AMPT key
● BW key
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Calibration ← Meas Settings
Under "Calibration", the second stage correction can be activated or deactivated. For
details refer also to chapter 3.6, "Calibration", on page 18.

2nd Stage Correction ← Calibration ← Meas Settings
Activates or deactivates the second stage correction.

For details refer also to chapter 3.6, "Calibration", on page 18.

"On" The calibration data recorded via the "Cal" softkey is used to correct
the measurement results (see "Cal" on page 59). The calibration
data is stored regardless of the state of the option.

"Off" No correction is applied to the measurement results.

Remote command: 
[SENSe: ​]CORRection[: ​STATe] ​ on page 102

Analyzer Settings ← Meas Settings
Under "Analyzer Settings", the general settings for the spectrum analyzer concerning
the level, attenuation and bandwidth of the signal to be measured are defined.

RBW ← Analyzer Settings ← Meas Settings
Specifies the resolution bandwidth for the measurement.

A large value improves the averaging of the display considerably, reduces the influ-
ence of external sources of interference, and permits the fastest measurement time
possible.
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A low value should only be used across a very small frequency range. For measure-
ments at low frequencies, the RBW must be reduced to prevent the LO frequency of
the analyzer from invalidating the measurement. At receive frequencies of 100 kHz, the
RBW must not exceed 10 kHz.

Remote command: 
[SENSe:​]BANDwidth|BWIDth[: ​RESolution] ​ on page 108

Sweep Time ← Analyzer Settings ← Meas Settings
Specifies the time one complete measurement sweep takes. Two sweeps are per-
formed for each measurement step (once with noise source on, once with noise source
off).

For narrow bandwidths, the sweep time should be increased in order to give accurate
measurement results.

Remote command: 
[SENSe: ​]SWEep: ​TIME​ on page 113

Settling Time ← Analyzer Settings ← Meas Settings
Specifies the time the DUT takes to settle after a noise source has been turned on or
off.

Most noise sources generate an interfering DC component in addition to the noise
spectrum. If the noise source is switched on or off, low-frequency DUTs may require
this settling time for coupling capacitors to be charged or discharged.

Remote command: 
SYSTem: ​CONFigure: ​DUT:​STIMe ​ on page 122

Average ← Analyzer Settings ← Meas Settings
Specifies the number of measurement sweeps over which the average is taken to pro-
duce the displayed measurement results.

The higher the number of sweeps, the more accurate the measurement results, but the
measurement time is significantly longer.

An average value of 1 means that each displayed result is produced from one mea-
surement sweep. This is sufficient for most cases.

Remote command: 
[SENSe:​]SWEep: ​COUNt​ on page 113

RF Attenuation ← Analyzer Settings ← Meas Settings
Specifies the attenuation that is applied to the received RF signal.

To obtain a low noise figure for the analyzer and hence more accurate noise measure-
ments, 0 dB should be set. For high DUT power levels or critical matching, a higher
setting is also possible. A setting of 10 dB will give a much better VSWR (voltage
standing wave ratio) of the analyzer, but will result in a worse noise figure of the ana-
lyzer.

Remote command: 
INPut: ​ATTenuation ​ on page 98
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Automatic Ref Level ← Analyzer Settings ← Meas Settings
Activates or deactivates the automatic reference level setting.

The automatic reference level measurement is performed as follows:

● 2nd stage correction activated:
At the beginning of the calibration measurement, several measurements are per-
formed at the first frequency test point and the reference level is calculated from
these results taking into account the maximum gain of the DUT (see "Range"
on page 51).

● 2nd stage correction deactivated:
At the beginning of the main measurement, several measurements are performed
at the first frequency test point and the reference level is calculated from these
results. The range setting is not significant.

"Off" Specify a reference level manually (see "Ref Level" on page 51).

"On" The reference level is measured automatically. The total measure-
ment time increases.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​RLEVel:​AUTO ​ on page 94

Ref Level ← Analyzer Settings ← Meas Settings
Specifies the reference level. It is only possible to enter a reference level manually, if
the automatic reference level is deactivated (see "Automatic Ref Level" on page 51).

The reference level should be about 5 to 15 dB above the noise display that occurs
with the DUT connected and the noise source activated.

Even for DUTs with a high-ripple frequency response it can be useful to enter the refer-
ence level manually, because an automatic reference level setting may not always
result in optimal settings.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​RLEVel​ on page 93

Range ← Analyzer Settings ← Meas Settings
Specifies the maximum gain expected from the DUT.

If the 2nd Stage Correction is activated, this value is used to calculate the automatic
reference level to ensure that the expected power of the measured signal will be within
the optimum operating range of the spectrum analyzer (see "Automatic Ref Level"
on page 51).

To ensure accurate measurement results, the range should not exceed the actual gain
of the DUT by more than a margin of 10 dB.

Remote command: 
SYSTem: ​CONFigure: ​DUT:​GAIN ​ on page 121

Preamp On/Off ← Analyzer Settings ← Meas Settings
Switches the preamplifier on and off.

If option R&S FSV-B22 is installed, the preamplifier is only active below 7 GHz.

If option R&S FSV-B24 is installed, the preamplifier is active for all frequencies.
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This function is not available for input from the R&S Digital I/Q Interface (option
R&S FSV-B17).

Remote command: 
INPut:​GAIN: ​STATe ​ on page 99

Input Settings/Baseband Settings ← Meas Settings
Input and Baseband settings are only required if the Digital Baseband Interface (option
R&S FSV-B17) is used to measure digital input.

For details see the Digital Baseband Interface (R&S FSV-B17) description of the base
unit.

Input ← Input Settings/Baseband Settings ← Meas Settings
Defines whether RF or digital input is to be measured. Digital input is only available if
the Digital Baseband Interface (option R&S FSV-B17) is installed.

Remote command: 
INPut: ​SELect​ on page 100

Input Sample Rate ← Input Settings/Baseband Settings ← Meas Settings
Defines the sample rate of the digital I/Q signal source. This sample rate must corre-
spond with the sample rate provided by the connected device, e.g. a generator.

Remote command: 
INPut: ​DIQ:​SRATe ​ on page 99

Full Scale Level ← Input Settings/Baseband Settings ← Meas Settings
The "Full Scale Level" defines the level that should correspond to an I/Q sample with
the magnitude "1".

The level is defined in Volts.

Remote command: 
INPut: ​DIQ:​RANGe[: ​UPPer] ​ on page 98

Generator Settings/ Generator Frequency ← Meas Settings
This section contains external generator settings for Fixed IF measurements if the
R&S FSV-B10 option is installed.

For details see chapter 4.2.3, "Fixed IF Measurements", on page 32.

Automatic Control ← Generator Settings/ Generator Frequency ← Meas Settings
Defines whether the R&S FSV-K30 controls the external generator via GPIB com-
mands or whether the external generator is controlled by the user.

"ON" R&S FSV-K30 issues GPIB commands during measurement execu-
tion in order to control the external generator.
Required for Fixed IF measurements, since R&S FSV-K30 expects
the LO frequency to be tuned to the test RF frequency automatically.
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"OFF" No GPIB commands are issued to the external generator. R&S FSV-
K30 assumes that the user sets up the external generator correctly.
None of the other parameters in the "Generator Settings" group are
available for editing when Automatic Control is set to OFF.
Only useful for "Fixed LO" measurements in which the external gen-
erator settings do not need to change during the measurement.

Note: If automatic control is deactivated, remote control of the exter-
nal generator (if in use) is automatically ended.

Remote command: 
SYSTem: ​CONFigure: ​GENerator: ​CONTrol:​STATe ​ on page 122

Source Power ← Generator Settings/ Generator Frequency ← Meas Settings
The output power of the external tracking generator. The default output power is -20
dBm. The range is specified in the data sheet.

Remote command: 
SOURce<n>: ​EXTernal<generator>: ​POWer[: ​LEVel] ​ on page 116

Type ← Generator Settings/ Generator Frequency ← Meas Settings
Generator type. See also chapter 3.10, "Overview of Generators Supported by the
R&S FSV", on page 22.

Remote command: 
SYSTem: ​COMMunicate: ​RDEVice: ​GENerator<generator>: ​TYPE​ on page 121

Interface ← Generator Settings/ Generator Frequency ← Meas Settings
Type of interface connection used. The following interfaces are currently supported:

● TCP/IP
● GPIB
For details on interfaces see the "Interfaces and Protocols" section in the R&S FSV
Quick Start Guide.

Remote command: 
SYSTem: ​COMMunicate: ​RDEVice: ​GENerator<generator>: ​INTerface ​
on page 119

TTL Synchronization ← Generator Settings/ Generator Frequency ← Meas Set-
tings
If available for the specified generator type, this option activates TTL synchronization
for GPIB connections.

For Noise Figure measurements (K30) this setting currently has no effect.

Remote command: 
SYSTem: ​COMMunicate: ​RDEVice: ​GENerator<generator>: ​LINK​ on page 120

Address ← Generator Settings/ Generator Frequency ← Meas Settings
For LAN connections: TCP/IP address.

For GPIB connections: GPIB address.
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For more information on configuring interfaces see the "Interfaces and Protocols" sec-
tion in the R&S FSV Quick Start Guide.

Remote command: 
SYSTem:​COMMunicate: ​RDEVice:​GENerator<generator>: ​LINK ​ on page 120

Reference ← Generator Settings/ Generator Frequency ← Meas Settings
Selects internal or external reference for the generator (default: internal).

Remote command: 
SOURce<n>: ​EXTernal<generator>: ​ROSCillator[: ​SOURce] ​ on page 116

Init Before Meas ← Generator Settings/ Generator Frequency ← Meas Settings
Specifies whether an initialisation sequence of GPIB commands containing the defined
generator settings is sent to an external signal generator prior to performing each mea-
surement. Sending an initialisation sequence before each measurement ensures that
the external generator is in the correct state to receive control commands during a
measurement sequence. On the other hand, initialising an external signal generator
before each measurement adds a time overhead to each measurement.

If enabled, the R&S FSV-K30 option initialises the selected external generator prior to
starting each requested measurement and switches on the generator's RF output.

If disabled, you must initialize the generator manually using the "Init Generator" softkey
in the INPUT/OUTPUT menu (see "Init Generator" on page 69).

Remote command: 
SYSTem:​CONFigure: ​GENerator: ​INITialise: ​AUTO ​ on page 123

Auto Switch Off ← Generator Settings/ Generator Frequency ← Meas Settings
Specifies whether a sequence of GPIB commands is sent to an external signal genera-
tor at the end of each measurement (after a single sweep or after a measurement is
aborted) to switch the generator's RF output off.

If enabled, the generator's RF output is switched OFF after each measurement. The
remote mode is also automatically ended after each measurement.

Otherwise, RF output must be switched off and remote mode ended manually.

Note: When the Noise measurement mode is closed, the RF output is automatically
switched off and remote mode ended.

Remote command: 
SYSTem: ​CONFigure: ​GENerator: ​SWITch:​AUTO ​ on page 123

Offset 1 / Factor 1 / Factor 2 / Offset 2 ← Generator Settings/ Generator Fre-
quency ← Meas Settings
The generator frequency is calculated according to the following formula:

Generator Frequency = [(LO + Offset 1) * Factor 1 / Factor 2)] + Offset 2
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The factors and offsets can be defined to compensate for any component that may
change the frequency between the generator and the device under test.

Remote command: 
Factor 1:
SOURce<n>: ​EXTernal<generator>: ​FREQuency[: ​FACTor]:​NUMerator ​
on page 114
Factor 2:
SOURce<n>: ​EXTernal<generator>: ​FREQuency[: ​FACTor]:​DENominator ​
on page 114
Offset 1/2:
SOURce<n>: ​EXTernal<generator>: ​FREQuency: ​OFFSet<m>​ on page 115

Result Frequency Start ← Generator Settings/ Generator Frequency ← Meas Set-
tings
For reference only: The start frequency for the generator, calculated from the config-
ured LO values in the "Frequency Table" and the offset values and factors in the "Gen-
erator Settings".

Result Frequency Stop ← Generator Settings/ Generator Frequency ← Meas Set-
tings
For reference only: The stop frequency for the generator, calculated from the config-
ured LO values in the "Frequency Table" and the offset values and factors in the "Gen-
erator Settings".

Display Settings
Opens the "Display Settings" dialog box to modify the graphical results display.
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Results Settings ← Display Settings
The settings that affect the overall results display

Combined Trace Display ← Results Settings ← Display Settings
Activates or deactivates the combined trace display of noise and gain results.

"ON" The noise and gain traces are displayed in the same trace display in
different colors.

"OFF" The noise and gain traces are displayed in different trace displays.

Remote command: 
DISPlay: ​FORMat​ on page 89

Noise Trace Settings ← Display Settings
The settings related to the graphical display of noise results.

Note that when using the Digital Baseband Interface (R&S FSV-B17), the Min/Max Y-
axis options are not available.

Y-Axis ← Noise Trace Settings ← Display Settings
Specifies the type of noise result that is to be displayed graphically:

● Noise Figure
● Noise Temperature
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● Off (no noise results are displayed graphically)

Remote command: 
DISPlay:​DATA: ​TRACe<t> ​ on page 89
DISPlay[: ​WINDow<n>]: ​TRACe<t>[: ​STATe]​ on page 90

Automatic Scaling ← Noise Trace Settings ← Display Settings
Activates or deactivates the automatic scaling of the Y-axis.

"On" The y-axis is scaled automatically. The automatic scaling algorithm
provides the optimal display of the complete range of results.

"Off" The automatic scaling of the y-axis is switched off, and the scale has
to be specified manually via the "Min Y-Axis NF"/"Min Y-Axis
Temp"/"Max Y-Axis NF"/"Max Y-Axis Temp" fields.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​AUTO​ on page 92

Min Y-Axis NF/Max Y-Axis NF ← Noise Trace Settings ← Display Settings
Specifies the minimum/maximum noise figure result that can be displayed graphically.
It is only possible to enter a value if the automatic scaling is deactivated (see "Auto-
matic Scaling" on page 57), and the y-axis is set to "Noise Figure" (see "Y-Axis"
on page 56).

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​BOTTom​ on page 92
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​TOP​ on page 94

Min Y-Axis Temp/Max Y-Axis Temp ← Noise Trace Settings ← Display Settings
Specifies the minimum/maximum noise temperature result that can be displayed
graphically. It is only possible to enter a value, if the automatic scaling is deactivated
(see "Automatic Scaling" on page 57), and the y-axis is set to "Noise Figure" (see "Y-
Axis" on page 56).

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​BOTTom​ on page 92
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​TOP​ on page 94

Symbols ← Noise Trace Settings ← Display Settings
Activates or deactivates the symbol representation. If activated, each measured value
is marked by a symbol. This helps to distinguish result types in a monochrome printout.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​SYMBols ​ on page 90

Gain Trace Settings ← Display Settings
The settings related to the graphical display of gain results.

Note that when using the Digital Baseband Interface (R&S FSV-B17), the Gain Trace
Settings are not available.
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Y-Axis ← Gain Trace Settings ← Display Settings
Activates or deactivates the display of the gain trace.

Remote command: 
DISPlay:​DATA: ​TRACe<t> ​ on page 89
DISPlay[:​WINDow<n>]: ​TRACe<t>[: ​STATe] ​ on page 90

Automatic Scaling ← Gain Trace Settings ← Display Settings
Activates or deactivates the automatic scaling of the Y-axis.

"On" The y-axis is scaled automatically. The automatic scaling algorithm
provides the optimal display of the complete range of results.

"Off" The automatic scaling of the y-axis is switched off, and the scale has
to be specified manually via the "Min Y-Axis"/"Max Y-Axis" fields.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​AUTO​ on page 92

Min Y-Axis/Max Y-Axis ← Gain Trace Settings ← Display Settings
Specifies the minimum/maximum gain result that can be displayed graphically. It is
only possible to enter a value if the automatic scaling is deactivated (see "Automatic
Scaling" on page 57), and the y-axis is activated (see "Y-Axis" on page 58 field).

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​BOTTom​ on page 92
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​TOP​ on page 94

Symbols ← Gain Trace Settings ← Display Settings
Activates or deactivates the symbol representation. If activated, each measured value
is marked by a symbol. This helps to distinguish result types in a monochrome printout.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​SYMBols ​ on page 90

Noise and Gain X-Axis Settings ← Display Settings
The settings related to noise and gain results

X-Axis ← Noise and Gain X-Axis Settings ← Display Settings
Specifies the scaling of the x-axis. This parameter is only editable in a frequency-con-
verting measurement mode.

Remote command: 
DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​X[:​SCALe] ​ on page 91

Editing Tables
The following functions are available as softkeys when a table in a dialog box is
focussed for editing.

Build Tbl ← Editing Tables
Updates the table according to the "Frequency Settings" (see the "Frequency Settings"
softkey, "Frequency Settings" on page 43).
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Exit ← Editing Tables
Exits the edit mode of a table.

Insert ← Editing Tables
Inserts a row above the currently selected row and sets the focus on the first field of
the new row.

This softkey is only available if the "Frequency Table" contains less than 100 measure-
ment steps.

Delete ← Editing Tables
Deletes the currently selected row. This action requires no confirmation.

Import ← Editing Tables
Opens a dialog box to select an Agilent ENR table to import. The file extension has to
be *.enr.

An import copies the ENR table into the default ENR table directory and replaces the
current table in the configuration dialog box.

Cal
Performs a calibration. The calibration status of the noise figure measurement is dis-
played in the title bar. For more details see chapter 3.6, "Calibration", on page 18

This softkey is only available if the 2nd Stage Correction option in the "Measurement
Settings" dialog box is activated.

Remote command: 
CONFigure: ​CORRection ​ on page 85

6.2 Softkeys of the Frequency Menu (R&S FSV-K30)

The FREQ key displays the "Frequency" menu.

Center Freq
Defines the center frequency.

Remote command: 
[SENSe: ​]FREQuency: ​CENTer ​ on page 111

Stepsize
Specifies the step size between the single measurement steps (i.e. entries in the fre-
quency table). For details see "Step Freq" on page 44.

Remote command: 
[SENSe: ​]FREQuency: ​STEP​ on page 112

Start
Specifies the start frequency. For details see "Start Freq" on page 43.

Remote command: 
[SENSe:​]FREQuency: ​STARt​ on page 112

 

Softkeys of the Frequency Menu (R&S FSV-K30)



Menu and Softkey Description (R&S FSV-K30)R&S® FSV-K30

60Operating Manual 1176.7562.02 ─ 02

Stop
Specifies the stop frequency. For details see "Stop Freq" on page 43.

Remote command: 
[SENSe: ​]FREQuency: ​STOP​ on page 112

LO/IF
Specifies the fixed local oscillator or fixed IF frequency. This function is only available if
a frequency-converting measurement mode is selected ("Mode" field).

For details see "Fixed LO" on page 45.

Remote command: 
LO: [SENSe: ​]CONFigure: ​MODE: ​SYSTem:​LOSCillator: ​FREQuency​
on page 110
IF: [SENSe: ​]CONFigure: ​MODE:​SYSTem: ​IF:​FREQuency ​ on page 109

Frequency Axis
Specifies the scaling of the x-axis. This function is only available in a frequency-con-
verting measurement mode.

For details see "X-Axis" on page 58.

Remote command: 
DISPlay[:​WINDow<n>]: ​TRACe<t>:​X[: ​SCALe]​ on page 91

Frequency Settings
Opens the "Frequency Settings" dialog box.

For details see "Frequency Settings" on page 43.

6.3 Softkeys of the Span Menu (R&S FSV-K30)

The SPAN key displays the "Span" menu.

Span
Specifies the frequency span.

Remote command: 
[SENSe:​]FREQuency: ​SPAN ​ on page 112

Sweep points
Defines the number of measured values to be collected during one sweep.

Remote command: 
[SENSe: ​]SWEep: ​POINts​ on page 113

Frequency Settings
Opens the "Frequency Settings" dialog box.

For details see "Frequency Settings" on page 43.

 

Softkeys of the Span Menu (R&S FSV-K30)



Menu and Softkey Description (R&S FSV-K30)R&S® FSV-K30

61Operating Manual 1176.7562.02 ─ 02

6.4 AMPT key

This key opens the "Measurement Settings" dialog box and jumps directly to the "RF
Attenuation" field (see "RF Attenuation" on page 50).

In addition, the standard "Noise" menu is displayed, see chapter 6.1, "Softkeys and
Settings of the Noise Menu (R&S FSV-K30)", on page 39.

6.5 BW key

This key opens the "Measurement Settings" dialog box and jumps directly to the
"RBW" field (see "RBW" on page 49).

6.6 Softkeys of the Sweep Menu (R&S FSV-K30)

The following table shows all softkeys available in the "Sweep" menu in Noise mode
(SWEEP key).

Continuous sweep.........................................................................................................61
Sweep Single................................................................................................................ 61
Cal.................................................................................................................................61
Fix Freq......................................................................................................................... 62

Continuous sweep
Sets the continuous sweep mode: the sweep takes place continuously according to the
trigger settings. This is the default setting.

Remote command: 
INITiate<n>: ​CONTinuous ​ on page 100
CONFigure: ​LIST:​CONTinuous ​ on page 87

Sweep Single
Sets the single sweep mode. The measurement stops after the defined number of
sweeps (Sweep points setting in the "Measurement Settings") has been performed. If a
measurement is started while another measurement is in progress, the first measure-
ment is aborted and the new measurement started immediately.

For further details refer to chapter 3.1, "Measurement Types", on page 11.

Remote command: 
INITiate<n>: ​CONTinuous​ on page 100
CONFigure: ​LIST: ​SINGle​ on page 87

Cal
Performs a calibration. The calibration status of the noise figure measurement is dis-
played in the title bar. For more details see chapter 3.6, "Calibration", on page 18
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This softkey is only available if the 2nd Stage Correction option in the "Measurement
Settings" dialog box is activated.

Remote command: 
CONFigure: ​CORRection ​ on page 85

Fix Freq
Starts a fixed frequency measurement for the frequency that is currently selected in the
"Frequency List Results".

This softkey is only available after a frequency list measurement has been completed
and the measurement results are displayed in list form ("Display Settings" on page 55
softkey).

Remote command: 
CONFigure: ​SINGle ​ on page 87
[SENSe: ​]FREQuency[: ​CW|: ​FIXed]​ on page 110

6.7 Softkeys of the Trace Menu (R&S FSV-K30)

Using the trace memory facility, you can save graphical display results (max. 3 trace
sets) for comparison with subsequent measurements. This facility is recommended in
order to compare and to document the effects of small changes on the DUT.

The following table shows all softkeys available in the "Trace" menu in Noise mode
(TRACE key).

Display Graph/List.........................................................................................................62
Data->Mem1/ Data->Mem2/ Data->Mem3....................................................................62
Data On/Off................................................................................................................... 63
Mem1 On/Off/Mem2 On/Off/Mem3 On/Off................................................................... 63
ASCII File Export...........................................................................................................63
Decim Sep.....................................................................................................................63

Display Graph/List
Switches between graphical and table display of the measurement results (see chap-
ter 3.4, "Result Displays", on page 15).

Data->Mem1/ Data->Mem2/ Data->Mem3
Saves the current trace results to trace memory <n>. If a trace memory <n> contains
data, the corresponding softkey has a green background. The content of the trace
memory <n> is displayed via the Mem1 On/Off/Mem2 On/Off/Mem3 On/Off/" softkeys.

If data is transferred to a trace memory that already contains trace data, the new trace
data overwrites the current trace data in the memory.

Remote command: 
CONFigure: ​ARRay:​MEMory<1…3> ONCE ​ on page 85
FETCh: ​ARRay:​MEMory<1…3>: ​NOISe: ​FIGure? ​ on page 96
FETCh: ​ARRay:​MEMory<1…3>: ​NOISe: ​GAIN?​ on page 96
FETCh: ​ARRay:​NOISE: ​TEMPerature? ​ on page 96
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Data On/Off
Switches the display of the current measurement results on or off. The display of trace
memory results is not affected if this softkey is pressed. If a new frequency list mea-
surement is started, the display of the current result trace is switched on automatically.

Remote command: 
DISPlay: ​CURRent: ​DATA[:​STATe] ​ on page 88

Mem1 On/Off/Mem2 On/Off/Mem3 On/Off
Switches the display of trace memory <n> on or off. This softkey is not available if no
data is held in the selected trace memory.

Remote command: 
DISPlay: ​ARRay: ​MEMory<m>[: ​STATe]​ on page 88

ASCII File Export
Opens the "ASCII File Export Name" dialog box and saves the active peak list in ASCII
format to the specified file and directory.

The file consists of the header containing important scaling parameters and a data sec-
tion containing the marker data. For details on an ASCII file see chapter 3.9, "ASCII
File Export Format", on page 21.

This format can be processed by spreadsheet calculation programs, e.g. MS-Excel. It
is necessary to define ';' as a separator for the data import. Different language versions
of evaluation programs may require a different handling of the decimal point. It is there-
fore possible to select between separators '.' (decimal point) and ',' (comma) using the
"Decim Sep" softkey (see "Decim Sep" on page 63).

Remote command: 
FORMat: ​DEXPort: ​DSEParator ​ on page 97

Decim Sep
Selects the decimal separator with floating-point numerals for the ASCII Trace export
to support evaluation programs (e.g. MS-Excel) in different languages. The values '.'
(decimal point) and ',' (comma) can be set.

Remote command: 
FORMat: ​DEXPort:​DSEParator ​ on page 97

6.8 Softkeys of the Marker Menu (R&S FSV-K30)

The following table shows all softkeys available in the "Marker" menu in Noise mode
(MKR key).

The R&S FSV-K30 option now has 4 markers, each of which can be set either to the
noise, the gain, or any of the traces in memory.

Marker 1/2/3/4............................................................................................................... 64
Marker to Trace.............................................................................................................64
All Marker Off................................................................................................................ 64
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Marker 1/2/3/4
Activates one of four possible markers and opens an edit dialog box to enter a value
for the marker to be set to. Pressing the softkey again deactivates the marker. These
softkeys are only available if measurement results are displayed.

Remote command: 
CALCulate<n>: ​MARKer<m>[: ​STATe] ​ on page 83
CALCulate<n>: ​MARKer<m>: ​X​ on page 84
CALCulate<n>: ​MARKer<m>: ​Y?​ on page 84

Marker to Trace
Opens a dialog box to select the trace (noise figure, gain or memory trace), on which
the currently selected marker is to be placed.

This softkey is only available if measurement results are displayed.

Remote command: 
CALCulate<n>: ​MARKer<m>: ​TRACe ​ on page 83

All Marker Off
Switches off the active marker. This softkey is only available if measurement results
are displayed.

Remote command: 
CALCulate<n>: ​MARKer<m>: ​AOFF ​ on page 82

6.9 Softkeys of the Marker To Menu (R&S FSV-K30)

The following table shows all softkeys available in the "Marker To" menu in Noise
mode (MKR-> key).

Select Marker (No)........................................................................................................ 64
Peak.............................................................................................................................. 64
Min................................................................................................................................ 64
Marker to Trace.............................................................................................................65

Select Marker (No)
Opens a submenu to select and display one of 4 markers. "(No)" indicates the number
of the currently active marker. Peak and Min functions apply to this marker.

Peak
Sets the active marker/delta marker to the highest maximum of the trace.

Remote command: 
CALCulate<n>: ​MARKer<m>: ​MAXimum[:​PEAK] ​ on page 82

Min
Sets the active marker/delta marker to the minimum of the selected trace.

Remote command: 
CALCulate<n>: ​MARKer<m>: ​MINimum[: ​PEAK]​ on page 82
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Marker to Trace
Opens a dialog box to select the trace (noise figure, gain or memory trace), on which
the currently selected marker is to be placed.

This softkey is only available if measurement results are displayed.

Remote command: 
CALCulate<n>: ​MARKer<m>: ​TRACe ​ on page 83

6.10 Softkeys of the Lines Menu (R&S FSV-K30)

The following table shows all softkeys available in the "Lines" menu in Noise mode
(LINES key).

New............................................................................................................................... 65
└ Name.............................................................................................................. 65
└ Limit................................................................................................................ 65
└ Comment........................................................................................................ 66
└ Frequency.......................................................................................................66
└ Limit................................................................................................................ 66

Edit................................................................................................................................ 66
Enable/Disable.............................................................................................................. 66
Delete............................................................................................................................66
Edit Table mode............................................................................................................ 66

└ Exit..................................................................................................................66
└ Insert...............................................................................................................66
└ Delete..............................................................................................................66

New
Displays the "Limit Line" dialog box in edit mode with all fields necessary to define a
new limit line.

Name ← New
Specifies the name of the limit line to uniquely identify every limit line. Any combination
of alphanumeric characters is allowed. If the entered name already exists, an error
message is displayed with the request to alter the name.

Remote command: 
CALCulate<n>: ​LIMit<k>: ​NAME​ on page 79

Limit ← New
Specifies the result type (noise or gain) and the limit type (upper or lower) for the limit
line.

Remote command: 
CALCulate<n>: ​LIMit<m>: ​TRACe ​ on page 80

 

Softkeys of the Lines Menu (R&S FSV-K30)



Menu and Softkey Description (R&S FSV-K30)R&S® FSV-K30

66Operating Manual 1176.7562.02 ─ 02

Comment ← New
Specifies a description for the limit line. Any combination of alphanumeric characters is
allowed.

Remote command: 
CALCulate<n>: ​LIMit<k>: ​COMMent​ on page 76

Frequency ← New
Specifies the receive frequencies.

Remote command: 
CALCulate<n>: ​LIMit<k>:​CONTrol[: ​DATA] ​ on page 76

Limit ← New
Specifies the limits for the receive frequencies.

Remote command: 
CALCulate<n>: ​LIMit<k>: ​LOWer[:​DATA] ​ on page 77
CALCulate<n>: ​LIMit<k>: ​UPPer[:​DATA] ​ on page 80

Edit
Displays the "Limit Line" dialog box in edit mode with all data of the selected limit line.
For further details refer to the New softkey.

Enable/Disable
Enables or disables the selected limit line. Limit checking is only performed for activa-
ted limit lines. Only one limit line of each type can be active at a given time.

Remote command: 
CALCulate<n>: ​LIMit<k>: ​STATe ​ on page 79
CALCulate<n>: ​LIMit<k>: ​LOWer: ​STATe​ on page 79
CALCulate<n>: ​LIMit<k>: ​UPPer: ​STATe​ on page 81

Delete
Deletes the selected limit line.

Remote command: 
CALCulate<n>: ​LIMit<k>: ​DELete​ on page 77

Edit Table mode
The following functions are available if a limit line table is focussed for editing. For
details see chapter 5.2, "Working With Limit Lines", on page 37 and chapter 5.1, "Edit-
ing Tables", on page 37

Exit ← Edit Table mode
Exits the edit mode of a table.

Insert ← Edit Table mode
Inserts a row above the currently selected row and sets the focus on the first field of
the new row.

Delete ← Edit Table mode
Deletes the currently selected row. This action requires no confirmation.
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6.11 Softkeys of the Input/Output Menu (R&S FSV-K30)

The following chapter describes all softkeys available in the "Input/Output" menu for
Noise Figure measurements. Note that the digital baseband functions are only availa-
ble if the optional Digital Baseband Interface (R&S FSV-B17) is installed.

For details see the base unit description.

Input (AC/DC)................................................................................................................67
EXIQ..............................................................................................................................67

└ TX Settings..................................................................................................... 67
└ RX Settings.....................................................................................................68
└ Send To.......................................................................................................... 68
└ Firmware Update............................................................................................ 68
└ R&S Support...................................................................................................68
└ DigIConf..........................................................................................................68

Init Generator................................................................................................................ 69

Input (AC/DC)
Toggles the RF input of the R&S FSV between AC and DC coupling.

This function is not available for input from the R&S Digital I/Q Interface (option
R&S FSV-B17).

Remote command: 
INPut: ​COUPling ​ on page 98

EXIQ
Opens a configuration dialog box for an optionally connected R&S EX-IQ-BOX and a
submenu to access the main settings quickly.

Note: The EX-IQ-Box functionality is not supported for R&S FSV models
1321.3008Kxx.
If the optional R&S DigIConf software is installed, the submenu consists only of one
key to access the software. Note that R&S DigIConf requires a USB connection
(not LAN!) from the R&S FSV to the R&S EX-IQ-BOX in addition to the R&S Digi-
tal I/Q Interface connection. R&S DigIConf version 2.10 or higher is required.
For typical applications of the R&S EX-IQ-BOX see also the description of the R&S
Digital I/Q Interface (R&S FSV-B17) in the base unit manual.

For details on configuration see the "R&S®Ex I/Q Box - External Signal Interface Mod-
ule Manual".

For details on installation and operation of the R&S DigIConf software, see the
"R&S®EX-IQ-BOX Digital Interface Module R&S®DigIConf Software Operating Man-
ual".

TX Settings ← EXIQ
Opens the "EX-IQ-BOX Settings" dialog box to configure the R&S FSV for digital out-
put to a connected device ("Transmitter" Type).
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RX Settings ← EXIQ
Opens the "EX-IQ-BOX Settings" dialog box to configure the R&S FSV for digital input
from a connected device ("Receiver" Type).

Send To ← EXIQ
The configuration settings defined in the dialog box are transferred to the R&S EX-IQ-
BOX.

Firmware Update ← EXIQ
If a firmware update for the R&S EX-IQ-BOX is delivered with the R&S FSV firmware,
this function is available. In this case, when you select the softkey, the firmware update
is performed.

R&S Support ← EXIQ
Stores useful information for troubleshooting in case of errors.

This data is stored in the C:\R_S\Instr\user\Support directory on the instru-
ment.

If you contact the Rohde&Schwarz support to get help for a certain problem, send
these files to the support in order to identify and solve the problem faster.

DigIConf ← EXIQ
Starts the optional R&S DigIConf application. This softkey is only available if the
optional software is installed.

To return to the R&S FSV application, press any key on the front panel. The applica-
tion is displayed with the "EXIQ" menu, regardless of which key was pressed.

For details on the R&S DigIConf application, see the "R&S®EX-IQ-BOX Digital Inter-
face Module R&S®DigIConf Software Operating Manual".

Note: If you close the R&S DigIConf window using the "Close" icon, the window is
minimized, not closed.
If you select the "File > Exit" menu item in the R&S DigIConf window, the application is
closed. Note that in this case the settings are lost and the EX-IQ-BOX functionality is
no longer available until you restart the application using the "DigIConf" softkey in the
R&S FSV once again.

Remote command: 
Remote commands for the R&S DigIConf software always begin with SOURce:EBOX.
Such commands are passed on from the R&S FSV to the R&S DigIConf automatically
which then configures the R&S EX-IQ-BOX via the USB connection.
All remote commands available for configuration via the R&S DigIConf software are
described in the "R&S®EX-IQ-BOX Digital Interface Module R&S®DigIConf Software
Operating Manual".
Example 1:
SOURce:EBOX:*RST
SOURce:EBOX:*IDN?
Result:
"Rohde&Schwarz,DigIConf,02.05.436 Build 47"
Example 2:
SOURce:EBOX:USER:CLOCk:REFerence:FREQuency 5MHZ
Defines the frequency value of the reference clock.

Softkeys of the Input/Output Menu (R&S FSV-K30)
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Init Generator
This softkey immediately initializes the external signal generator with the settings con-
figured in the R&S FSV-K30 option (see "Generator Settings/ Generator Frequency"
on page 52). It also switches the external generator's RF output on. If any of the exter-
nal generator settings have changed, initialization is required before a measurement
using the external generator control can be run. Alternatively, initialization can be per-
formed automatically before each measurement (see "Init Before Meas" on page 54).

Remote command: 
SYSTem: ​CONFigure: ​GENerator: ​INITialise: ​IMMediate ​ on page 123

Softkeys of the Input/Output Menu (R&S FSV-K30)
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7 Status Reporting System (R&S FSV-K30)
Additionally to the registers provided by the base system, the following registers are
used or modified in the Noise Figure Measurements option (R&S FSV-K30):

● chapter 7.1, "STATus:OPERation Register", on page 70

Although this register is provided by the base system, the Noise Figure Measurements
option makes use of bits not used within the base system.

● chapter 7.2, "STATus:QUEStionable Register", on page 70

Although this register is provided by the base system, the Noise Figure Measurements
option uses different bits and definitions.

● chapter 7.3, "STATus:QUEStionable:CORRection Register", on page 71

This register is provided by the R&S FSV-K30 option.

The following registers are provided by the base system and are not available from the
Noise Figure Measurements option (R&S FSV-K30) command tree:

● STATus:QUEStionable:ACPLimit Register
● STATus:QUEStionable:LIMit Register
● STATus:QUEStionable:LMARgin Register
● STATus:QUEStionable:POWer Register

Detailed information on the status registers of the base system is given in section Sta-
tus Reporting System. In this section, only the new and altered status registers/bits for
the Noise Figure Measurements option (R&S FSV-K30) are described.

7.1 STATus:OPERation Register

Additionally to the bits assigned by the base system (for details refer to STA-
Tus:OPERation Register), the bits no. 4 and 7 are defined:

Bit No Meaning

4 MEASuring

A '1' in this bit position indicates that a measurement is in progress.

7 CORRecting

Indicates that a user calibration is in progress.

7.2 STATus:QUEStionable Register

Additionally to the bits assigned by the base system (for details refer to STA-
Tus:QUEStionable Register), the bit no. 11 is defined differently:

 

 

 

STATus:OPERation Register
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Bit No Meaning

11 CORRection

This bit is set if questionable correction data occurs (see also section STA-
Tus:QUEStionable:CORRection Register).

7.3 STATus:QUEStionable:CORRection Register

This register comprises information about the correction state of noise measurements.
It can be queried by STATus:QUEStionable:CONDition? and
STATus:QUEStionable[:EVENt]? commands.

Bit No Meaning

0 NO CORRection

User calibration is required (i.e. not done, or setup changed). Initial value is 1. Will
remain 1 until a user calibration is done. Set to 1 at the start of a user calibration. It
will go to 0 at the end of a user calibration only if all points of at least one range have
been calibrated.

1 Not used

2 Deprecated; not used

3 Missing Loss or ENR values

No ENR, Loss In and/or Loss Out can be determined for one or all of the measure-
ment frequencies. This occurs when using tables of ENR, Loss In and/or Loss out
values. Check that the frequency ranges of the tables cover the range of frequencies
to be measured. For each measurement frequency where ENR, Loss In or Loss Out
cannot be determined, 0 is used.

4 to 15 Not used

 

STATus:QUEStionable:CORRection Register
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8 Remote Control Commands
This section describes the remote commands specific to the Noise Figure Measure-
ments option (R&S FSV-K30). The abbreviation NF stands for the operating mode of
noise figure measurements. For details on conventions used in this chapter refer to
chapter 8.1, "Notation", on page 72.

For further information on analyzer or basic settings commands, refer to the corre-
sponding Subsystem in the base unit description.

8.1 Notation........................................................................................................................72

8.2 CALCulate Subsystem (Noise Figure, R&S FSV-K30)............................................. 75

8.2.1 CALCulate:LIMit Subsystem (Noise Figure, K30)......................................................... 75

8.2.2 CALculate:MARker subsystem..................................................................................... 82

8.3 CONFigure Subsystem (Noise Figure, R&S FSV-K30)............................................ 85

8.4 DISPlay Subsystem (Noise Figure, K30)...................................................................88

8.5 FETCh Subsystem (Noise Figure, K30).....................................................................95

8.6 FORMat Subsystem.................................................................................................... 97

8.7 INPut Subsystem.........................................................................................................98

8.8 INITiate Subsystem................................................................................................... 100

8.9 INSTrument Subsystem (Noise Figure, R&S FSV-K30)......................................... 101

8.10 SENSe Subsystem (Noise Figure, R&S FSV-K30)..................................................101

8.10.1 Equipment Settings Commands..................................................................................102

8.10.2 Measurement Settings (SENSe:CONFigure) Commands ......................................... 107

8.11 SOURce Subsystem..................................................................................................114

8.12 STATus Subsystem (Noise Figure, R&S FSV-K30)................................................117

8.13 SYSTem Subsystem (Noise Figure, R&S FSV-K30)...............................................119

8.1 Notation

In the following sections, all commands implemented in the instrument are first listed
and then described in detail, arranged according to the command subsystems. The
notation is adapted to the SCPI standard. The SCPI conformity information is included
in the individual description of the commands.

Individual Description

The individual description contains the complete notation of the command. An example
for each command, the *RST value and the SCPI information are included as well.

 

 

Notation
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The options and operating modes for which a command can be used are indicated by
the following abbreviations:

Abbreviation Description

A spectrum analysis

A-F spectrum analysis – span > 0 only (frequency mode)

A-T spectrum analysis – zero span only (time mode)

ADEMOD analog demodulation (option R&S FSV-K7)

BT Bluetooth (option R&S FSV-K8)

CDMA CDMA 2000 base station measurements (option R&S FSV-K82)

EVDO 1xEV-DO base station analysis (option R&S FSV-K84)

GSM GSM/Edge measurements (option R&S FSV-K10)

IQ IQ Analyzer mode

OFDM WiMAX IEEE 802.16 OFDM measurements (option R&S FSV-K93)

OFDMA/WiBro WiMAX IEEE 802.16e OFDMA/WiBro measurements (option R&S FSV-K93)

NF Noise Figure measurements (R&S FSV-K30)

PHN Phase Noise measurements (R&S FSV-K40)

PSM Power Sensor measurements (option R&S FSV-K9)

SFM Stereo FM measurements (optionR&S FSV-K7S)

SPECM Spectogram mode (option R&S FSV-K14)

TDS TD-SCDMA base station / UE measurements (option R&S FSV-K76/K77)

VSA Vector Signal Analysis (option R&S FSV-K70)

WCDMA 3GPP Base Station measurements (option R&S FSV-K72), 3GPP UE measure-
ments (option R&S FSV-K73)

WLAN WLAN TX measurements (option R&S FSV-K91)

The spectrum analysis mode is implemented in the basic unit. For the other modes, the
corresponding options are required.

Upper/Lower Case Notation

Upper/lower case letters are used to mark the long or short form of the key words of a
command in the description. The instrument itself does not distinguish between upper
and lower case letters.

Notation
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Special Characters

| A selection of key words with an identical effect exists for several commands. These keywords
are indicated in the same line; they are separated by a vertical stroke. Only one of these key-
words needs to be included in the header of the command. The effect of the command is inde-
pendent of which of the keywords is used.

Example:

SENSe:FREQuency:CW|:FIXed
The two following commands with identical meaning can be created. They set the fre-
quency of the fixed frequency signal to 1 kHz:

SENSe:FREQuency:CW 1E3
SENSe:FREQuency:FIXed 1E3
A vertical stroke in parameter indications marks alternative possibilities in the sense of
"or". The effect of the command differs, depending on which parameter is used.

Example: Selection of the parameters for the command

[SENSe<1…4>:]AVERage<1…4>:TYPE VIDeo | LINear

[] Key words in square brackets can be omitted when composing the header. The full command
length must be accepted by the instrument for reasons of compatibility with the SCPI standards.

Parameters in square brackets can be incorporated optionally in the command or omitted as
well.

{} Parameters in braces can be incorporated optionally in the command, either not at all, once or
several times.

Description of Parameters

Due to the standardization, the parameter section of SCPI commands consists always
of the same syntactical elements. SCPI has therefore specified a series of definitions,
which are used in the tables of commands. In the tables, these established definitions
are indicated in angled brackets (<…>) and is briefly explained in the following.

For details see the chapter "SCPI Command Structure" in the base unit description.

<Boolean>

This keyword refers to parameters which can adopt two states, "on" and "off". The "off"
state may either be indicated by the keyword OFF or by the numeric value 0, the "on"
state is indicated by ON or any numeric value other than zero. Parameter queries are
always returned the numeric value 0 or 1.

<numeric_value> <num>

These keywords mark parameters which may be entered as numeric values or be set
using specific keywords (character data). The following keywords given below are per-
mitted:

● MAXimum: This keyword sets the parameter to the largest possible value.

Notation
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● MINimum: This keyword sets the parameter to the smallest possible value.

● DEFault: This keyword is used to reset the parameter to its default value.

● UP: This keyword increments the parameter value.

● DOWN: This keyword decrements the parameter value.

The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding keywords to the command. They must be entered following
the quotation mark.

Example:

SENSe:FREQuency:CENTer? MAXimum
Returns the maximum possible numeric value of the center frequency as result.

<arbitrary block program data>

This keyword is provided for commands the parameters of which consist of a binary
data block.

8.2 CALCulate Subsystem (Noise Figure, R&S FSV-K30)

The CALCulate subsystem checks the marker functions and contains commands for
limit lines and their limit checks.

Note that the R&S FSV-K30 option now has 4 markers; thus, the suffix for
CALCulate:MARKer<m> commands can have the values 1-4.

8.2.1 CALCulate:LIMit Subsystem (Noise Figure, K30)......................................................... 75

8.2.2 CALculate:MARker subsystem..................................................................................... 82

8.2.1 CALCulate:LIMit Subsystem (Noise Figure, K30)

The CALCulate:LIMit subsystem contains commands for the limit lines and the corre-
sponding limit checks.

In contrast to the base unit, only 6 limit lines can be active at the same time (indicated
by LIMIT1 to LIMIT6). They are assigned to a particular measurement type rather than
a particular trace (see CALCulate<n>: ​LIMit<m>: ​TRACe ​ on page 80). Otherwise,
the commands are the same as for the base unit.

CALCulate<n>:LIMit<k>:COMMent.................................................................................... 76
CALCulate<n>:LIMit<k>:CONTrol[:DATA]...........................................................................76
CALCulate<n>:LIMit<k>:CONTrol:SHIFt.............................................................................77
CALCulate<n>:LIMit<k>:LOWer[:DATA]............................................................................. 77
CALCulate<n>:LIMit<k>:DELete........................................................................................77
CALCulate<n>:LIMit<k>:FAIL?.......................................................................................... 78
CALCulate<n>:LIMit<k>:LOWer:SHIFt............................................................................... 78
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CALCulate<n>:LIMit<k>:LOWer:STATe..............................................................................79
CALCulate<n>:LIMit<k>:NAME......................................................................................... 79
CALCulate<n>:LIMit<k>:STATe.........................................................................................79
CALCulate<n>:LIMit<m>:TRACe....................................................................................... 80
CALCulate<n>:LIMit<k>:UPPer[:DATA]..............................................................................80
CALCulate<n>:LIMit<k>:UPPer:SHIFt................................................................................ 81
CALCulate<n>:LIMit<k>:UPPer:STATe.............................................................................. 81

CALCulate<n>:LIMit<k>:COMMent <Comment>

This command defines a comment for the selected limit line in all windows.

Suffix: 
<n>

.
irrelevant

<k> Selects the limit line.

Parameters:
<Comment> String containing the comment. The maximum number of char-

acters the string may contain is 40.

Example: CALC:LIM5:COMM 'Upper limit for spectrum'
Defines the comment for limit line 5.

Manual operation: See "Comment" on page 66

CALCulate<n>:LIMit<k>:CONTrol[:DATA] <LimitLinePoints>

This command defines the horizontal definition points of a lower limit line.

Suffix: 
<n>

.
Selects the measurement window.

<k> 1...8
Selects the limit line.

Parameters:
<LimitLinePoints> Variable number of x-axis values.

Note that the number of horizontal values has to be the same as
the number of vertical values set with CALCulate<n>: ​
LIMit<k>: ​LOWer[:​DATA] ​ or CALCulate<n>: ​LIMit<k>: ​
UPPer[:​DATA] ​. If not, the R&S FSV either adds missing values
or ignores surplus values.
*RST: - (CALC:LIM is set to OFF)

Example: CALC:LIM2:CONT 1 MHz,30 MHz,100 MHz,300 MHz,1
GHz
Defines 5 reference values for the x-axis of limit line 2.
CALC:LIM2:CONT?
Outputs the reference values for the x-axis of limit line 2 separa-
ted by a comma.

Manual operation: See "Frequency" on page 66

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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CALCulate<n>:LIMit<k>:CONTrol:SHIFt <Distance>

This command moves a complete limit line horizontally.

Compared to defining an offset, this command actually changes the limit line definition
points by the value you define.

Suffix: 
<n>

.
Selects the measurement window.

<k> Selects the limit line.

Parameters:
<Distance> Numeric value that defines the distance of the shift.

The unit depends on the scale of the x-axis.

Example: CALC:LIM2:CONT:SHIF 50KHZ
Shifts all reference values of limit line 2 by 50 kHz.

CALCulate<n>:LIMit<k>:LOWer[:DATA] <LimitLinePoints>

This command defines the vertical definition points of a lower limit line.

If the measured values are smaller than the LOWer limit line, the limit check is violated.

Suffix: 
<n>

.
irrelevant

<k> 1...8
Selects the limit line.

Parameters:
<LimitLinePoints> Variable number of x-axis values.

Note that the number of horizontal values has to be the same as
the number of vertical values set with CALCulate<n>: ​
LIMit<k>: ​CONTrol[: ​DATA]​. If not, the R&S FSV either adds
missing values or ignores surplus values.
*RST: (LIMit:STATe is set to OFF)

Example: CALC:LIM2:LOW -30,-40,-10,-40,-30
Defines 5 lower limit values for limit line 2 in the preset unit.
CALC:LIM2:LOW?
Outputs the lower limit values of limit line 2 separated by a
comma.

Manual operation: See "Limit" on page 66

CALCulate<n>:LIMit<k>:DELete

This command deletes a limit line.

Suffix: 
<n>

.
irrelevant

<k> Selects the limit line.

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Example: CALC:LIM1:DEL
Deletes limit line 1.

Usage: Event

Manual operation: See "Delete" on page 66

CALCulate<n>:LIMit<k>:FAIL?

This command queries the result of a limit check.

Note that for SEM measurements, the limit line suffix <k> is irrelevant, as only one spe-
cific SEM limit line is checked for the currently relevant power class.

To get a valid result, you have to perform a complete measurement with synchroniza-
tion to the end of the measurement before reading out the result. This is only possible
for single sweeps.

Suffix: 
<n>

.
irrelevant

<k> limit line

Return values: 
<Result> 0

PASS
1
FAIL

Example: INIT;*WAI
Starts a new sweep and waits for its end.
CALC:LIM3:FAIL?
Queries the result of the check for limit line 3.

Usage: Query only

CALCulate<n>:LIMit<k>:LOWer:SHIFt <Distance>

This command moves a complete lower limit line vertically.

Compared to defining an offset, this command actually changes the limit line definition
points by the value you define.

Suffix: 
<n>

.
irrelevant

<k> Selects the limit line.

Parameters:
<Distance> Numeric value that defines the distance of the shift.

Example: CALC:LIM3:LOW:SHIF 20DB
Shifts all Y values of limit line 3 by 20 dB.

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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CALCulate<n>:LIMit<k>:LOWer:STATe <State>

This command turns a lower limit line on and off.

Before you can use this command, you have to select a limit line with
CALCulate<n>: ​LIMit<k>: ​NAME ​.

The limit check is activated separately with CALCulate<n>: ​LIMit<k>: ​STATe​. The
result of the limit check can be queried with CALCulate<n>: ​LIMit<k>: ​FAIL?​.

Suffix: 
<n>

.
irrelevant

<k> 1...8
Selects the limit line.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:LIM4:LOW:STAT ON
Switches on limit line 4 (lower limit).

Manual operation: See "Enable/Disable" on page 66

CALCulate<n>:LIMit<k>:NAME <Name>

This command selects a limit line that already exists or defines a name for a new limit
line.

Suffix: 
<n>

.
irrelevant

<k> 1...8 (NF: 1...6)
Selects the limit line.

Parameters:
<Name> String containing the limit line name.

*RST: REM1 to REM8 for lines 1 to 8

Example: CALC:LIM1:NAME 'FM1'
Assigns the name FM1 to limit line 1.

Manual operation: See "Name" on page 65

CALCulate<n>:LIMit<k>:STATe <State>

This command turns the limit check on and off.

To query the limit check result, use CALCulate<n>: ​LIMit<k>: ​FAIL?​.

Suffix: 
<n>

.
irrelevant

<k> Selects the limit line.

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:LIM:STAT ON
Switches on the limit check for limit line 1.

Manual operation: See "Enable/Disable" on page 66

CALCulate<n>:LIMit<m>:TRACe <MeasType>

This command assigns a limit line to a particular measurement type.

Suffix: 
<n>

.
1...4
irrelevant

<m> 1...6
limit line

Parameters:
<MeasType> NFIGure | TEFFective | GAIN

NFIGure
noise figure
TEFFective
noise temperature
GAIN
gain

Example: CALC:LIM2:TRAC NFIG
Assigns limit line 2 to the noise figure measurement.
CALC:LIM3:TRAC GAIN
Assigns limit line 3 to the gain measurement.

Mode: NF

Manual operation: See "Limit" on page 65

CALCulate<n>:LIMit<k>:UPPer[:DATA] <LimitLinePoints>

This command defines the vertical definition points of an upper limit line.

If the measured values exceed the UPPer limit line, the limit is violated.

Suffix: 
<n>

.
irrelevant

<k> 1...8
Selects the limit line.

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Parameters:
<LimitLinePoints> Variable number of x-axis values.

Note that the number of horizontal values has to be the same as
the number of vertical values set with CALCulate<n>: ​
LIMit<k>: ​CONTrol[: ​DATA] ​. If not, the R&S FSV either adds
missing values or ignores surplus values.
*RST: (LIMit:STATe is set to OFF)

Example: CALC:LIM2:UPP -10,0,0,-10,-5
Defines 5 upper limit values for limit line 2 in the preset unit.
CALC:LIM2:UPP?
Outputs the upper limit values for limit line 2 separated by a
comma.

Manual operation: See "Limit" on page 66

CALCulate<n>:LIMit<k>:UPPer:SHIFt <Value>

This command moves a limit line by the indicated value in Y direction.

Suffix: 
<n>

.
irrelevant

<k> limit line

Parameters:
<Value> <numeric_value>

Example: CALC:LIM3:UPP:SHIF 20
Shifts all Y values of limit line 3 by 20 limit line units, e.g. dB.

Mode: A, ADEMOD, CDMA, EVDO, NF, TDS

CALCulate<n>:LIMit<k>:UPPer:STATe <State>

This command turns a lower limit line on and off.

Before you can use this command, you have to select a limit line with
CALCulate<n>: ​LIMit<k>: ​NAME​.

The limit check is activated separately with CALCulate<n>: ​LIMit<k>: ​STATe ​. The
result of the limit check can be queried with CALCulate<n>: ​LIMit<k>: ​FAIL? ​.

Suffix: 
<n>

.
irrelevant

<k> 1...8
Selects the limit line.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Example: CALC:LIM4:UPP:STAT ON
Switches on limit line 4 (upper limit).

Manual operation: See "Enable/Disable" on page 66

8.2.2 CALculate:MARker subsystem

CALCulate<n>:MARKer<m>:AOFF

This command all markers off, including delta markers and marker measurement func-
tions.

Suffix: 
<n>

.
Selects the measurement window.

<m> depends on mode
irrelevant

Example: CALC:MARK:AOFF
Switches off all markers.

Usage: Event

Manual operation: See "All Marker Off" on page 64

CALCulate<n>:MARKer<m>:MAXimum[:PEAK]

This command positions the marker on the current trace maximum.

The corresponding marker is activated first or switched to the marker mode.

If no maximum value is found on the trace (level spacing to adjacent values < peak
excursion), an execution error (error code: -200) is produced.

Suffix: 
<n>

.
Selects the measurement window.

<m> depends on mode
Selects the marker.

Example: CALC:MARK2:MAX
Positions marker 2 to the maximum value of the trace.

Usage: Event

Manual operation: See "Peak" on page 64

CALCulate<n>:MARKer<m>:MINimum[:PEAK]

This command positions the marker on the current trace minimum.

The corresponding marker is activated first or switched to marker mode, if necessary.

If no minimum value is found on the trace (level spacing to adjacent values < peak
excursion), an execution error (error code: -200) is produced.

 

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Suffix: 
<n>

.
Selects the measurement window.

<m> depends on mode
Selects the marker.

Example: CALC:MARK2:MIN
Positions marker 2 to the minimum value of the trace.

Usage: Event

Manual operation: See "Min" on page 64

CALCulate<n>:MARKer<m>[:STATe] <State>

This command turns markers on and off.

If the corresponding marker number is currently active as a deltamarker, it is turned
into a normal marker.

Suffix: 
<n>

.
Selects the measurement window.

<m> depends on mode
Selects the marker.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK3 ON
Switches on marker 3 or switches to marker mode.

Manual operation: See "Marker 1/2/3/4" on page 64

CALCulate<n>:MARKer<m>:TRACe <Trace>

This command selects the trace a marker is positioned on.

The corresponding trace must have a trace mode other than "Blank".

If necessary, the corresponding marker is switched on prior to the assignment.

Suffix: 
<n>

.
Selects the measurement window.

<m> depends on mode
Selects the marker.

CALCulate Subsystem (Noise Figure, R&S FSV-K30)
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Parameters:
<Trace> NOISe | GAIN | NMEM1 | NMEM2 | NMEM3 | GMEM1 |

GMEM2 | GMEM3
NOISe: Current noise trace
GAIN: Current gain trace
NMEM1 | NMEM2 | NMEM3: noise trace stored in memory 1, 2
or 3
The memory must have been populated first using the command
CONFigure: ​ARRay: ​MEMory<1…3> ONCE ​
GMEM1 | GMEM2 | GMEM3: gain trace stored in memory 1, 2,
or 3
The memory must have been populated first using the command
CONFigure: ​ARRay: ​MEMory<1…3> ONCE ​

Example: CALC:MARK3:TRAC 2
Assigns marker 3 to trace 2.

Manual operation: See "Marker to Trace" on page 64

CALCulate<n>:MARKer<m>:X <Position>

This command positions a marker on a particular coordinate on the x-axis.

Suffix: 
<n>

.
Selects the measurement window.

<m> Selects the marker.

Parameters:
<Position> Numeric value that defines the marker position on the x-axis.

The unit is either Hz (frequency domain) or s (time domain) or
dB (statistics).
Range: The range depends on the current x-axis range.

Example: CALC:MARK2:X 1.7MHz
Positions marker 2 to frequency 1.7 MHz.

Manual operation: See "Marker 1/2/3/4" on page 64

CALCulate<n>:MARKer<m>:Y?

This command queries the measured value of a marker.

The corresponding marker is activated before or switched to marker mode, if neces-
sary.

To get a valid result, you have to perform a complete measurement with synchroniza-
tion to the end of the measurement before reading out the result. This is only possible
for single sweeps.

Suffix: 
<n>

.
Selects the measurement window.

<m> Selects the marker.
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Return values: 
<Result> The measured value of the selected marker is returned.

Example: INIT:CONT OFF
Switches to single sweep mode.
CALC:MARK2 ON
Switches marker 2.
INIT;*WAI
Starts a sweep and waits for the end.
CALC:MARK2:Y?
Outputs the measured value of marker 2.

Usage: Query only

Manual operation: See "Marker 1/2/3/4" on page 64

8.3 CONFigure Subsystem (Noise Figure, R&S FSV-K30)

The CONFigure subsystem contains commands for configuring complex measurement
tasks.

CONFigure:ARRay:MEMory<1…3> ONCE.........................................................................85
CONFigure:CORRection...................................................................................................85
CONFigure:FREQ:CONTinuous........................................................................................ 86
CONFigure:FREQ:SINGle.................................................................................................86
CONFigure:LIST:CONTinuous...........................................................................................87
CONFigure:LIST:SINGle...................................................................................................87
CONFigure:SINGle...........................................................................................................87

CONFigure:ARRay:MEMory<1…3> ONCE

This command saves the current trace results (noise figure, noise temperature and
noise gain traces) to trace memory <n>.

Example: INIT
Starts a new measurement, if no measurement sequence is
already in progress.
CONF:ARR:MEM2 ONCE
Copies the last recorded measurement result into the memory 2.

Usage: Event

Mode: NF

Manual operation: See "Data->Mem1/ Data->Mem2/ Data->Mem3" on page 62

CONFigure:CORRection

This command configures for a second stage correction measurement.
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Example: CONF:CORR
Configures to run second stage correction measure measure-
ments.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.

Usage: Event

Mode: NF

Manual operation: See "Cal" on page 59

CONFigure:FREQ:CONTinuous

This command configures a single frequency measurement in continuous sweep
mode.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Example: FREQ:STAR 20MHz
Defines the single frequency to be measured as 20 MHz.
CONF:FREQ:CONT
Configures to run a single frequency measurement in continuous
sweep mode.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.

Usage: Event

Mode: NF

Manual operation: See "Single Freq" on page 43

CONFigure:FREQ:SINGle

This command configures a single frequency measurement in single sweep mode.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Example: FREQ:STAR 20MHz
Defines the single frequency to be measured as 20 MHz.
CONF:FREQ:SING
Configures to run a single frequency measurement in single
sweep mode.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.

Usage: Event

Mode: NF

Manual operation: See "Single Freq" on page 43
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CONFigure:LIST:CONTinuous

This command configures a frequency list measurement in continuous sweep mode.

Example: CONF:LIST:CONT
Configures to run a frequency list measurement in continuous
sweep mode.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.

Usage: Event

Mode: NF

Manual operation: See "Continuous sweep" on page 61

CONFigure:LIST:SINGle

This command configures a frequency list measurement in single sweep mode.

Example: CONF:LIST:SING
Configures to run frequency list measurement in single sweep
modes.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.

Usage: Event

Mode: NF

Manual operation: See "Sweep Single" on page 61

CONFigure:SINGle

This command configures a fixed frequency measurement. It requires a frequency list
measurement to have been performed previously (see CONFigure: ​LIST:​SINGle ​/
CONFigure: ​LIST: ​CONTinuous ​ on page 87 or CONFigure: ​FREQ: ​SINGle​/
CONFigure: ​FREQ: ​CONTinuous ​ on page 86

Example: CONF:LIST:SING
Configures to run a frequency list measurement in single sweep
mode.
INIT
Performs the frequency list measurement.
CONF:SING
Configures to run fixed frequency measurements.
FREQ 10MHz
Sets a fixed frequency of 10 MHz.
INIT
Starts a new measurement, if no measurement sequence is
already in progress.
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Usage: Event

Mode: NF

Manual operation: See "Fix Freq" on page 62

8.4 DISPlay Subsystem (Noise Figure, K30)

The DISPLay subsystem controls the selection and presentation of textual and graphic
information as well as of measurement data on the display.

DISPlay:ARRay:MEMory<m>[:STATe]............................................................................... 88
DISPlay:CURRent:DATA[:STATe]..................................................................................... 88
DISPlay:DATA:TRACe<t>.................................................................................................89
DISPlay:FORMat............................................................................................................. 89
DISPlay[:WINDow<n>]:TABLe...........................................................................................90
DISPlay[:WINDow<n>]:TRACe<t>[:STATe].........................................................................90
DISPlay[:WINDow<n>]:TRACe<t>:SYMBols....................................................................... 90
DISPlay[:WINDow<n>]:TRACe<t>:X[:SCALe]..................................................................... 91
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:AUTO........................................................... 92
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:BOTTom....................................................... 92
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel......................................................... 93
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel:AUTO............................................... 94
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:TOP..............................................................94

DISPlay:ARRay:MEMory<m>[:STATe] <State>

This command switches the display of the trace memory on or off.

Suffix: 
<m>

.
1...3
trace memory

Parameters:
<State> ON | OFF

*RST: OFF

Example: DISP:ARR:MEM2 ON
Switches on the display of memory 2.

Mode: NF

Manual operation: See "Mem1 On/Off/Mem2 On/Off/Mem3 On/Off" on page 63

DISPlay:CURRent:DATA[:STATe] <State>

This command switches the display of the current measurement results on or off.

Parameters:
<State> ON | OFF

*RST: ON
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Example: DISP:CURR:DATA OFF
Removes the current result traces from display.

Mode: NF

Manual operation: See "Data On/Off" on page 63

DISPlay:DATA:TRACe<t> <ResultType>

This command specifies the type of noise results to be displayed in trace 1.

Suffix: 
<t>

.
1
trace; only trace 1 is valid for noise results

Return values: 
<ResultType> NFIGure | TEFFective | GAIN

NFIGure
noise figure results in dB
TEFFective
noise temperature in K
GAIN
gain
Gain is not available when using Digital Baseband Interface
(R&S FSV-B17).
*RST: NFIGure

Example: DISP:DATA:TRAC1 NFIG
Displays the noise figure results in trace 1.

Mode: NF

Manual operation: See "Y-Axis" on page 56
See "Y-Axis" on page 58

DISPlay:FORMat <Format>

This command activates or deactivates the combined trace display of noise and gain
results.

Combined trace display (SPLit) is not available when using Digital Baseband Interface
(R&S FSV-B17).

Parameters:
<Format> SPLit | SINGle

*RST: SING

Example: DISP:FORM SPL
Displays noise and gain results in separate graphs.

Mode: NF

Manual operation: See "Combined Trace Display" on page 56
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DISPlay[:WINDow<n>]:TABLe <State>

This command activates or deactivates the result table display.

Suffix: 
<n>

.
1
window

Parameters:
<State> ON | OFF

*RST: OFF

Example: DISP:TABL ON
Displays the table of results.

Mode: NF

DISPlay[:WINDow<n>]:TRACe<t>[:STATe] <State>

This command activates or deactivates the display of the corresponding trace and rela-
ted information.

Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.
Trace 2 is not available when using Digital Baseband Interface
(R&S FSV-B17).

Parameters:
<State> ON | OFF

*RST: ON for both traces

Example: DISP:TRAC OFF
Switches off the display of trace 1 (noise results).
DISP:TRAC2 OFF
Switches off the display of trace 2 (gain results).

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Y-Axis" on page 56
See "Y-Axis" on page 58

DISPlay[:WINDow<n>]:TRACe<t>:SYMBols <State>

This command activates or deactivates the display of the symbols to mark the mea-
surement points for the specified trace.
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Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.

Parameters:
<State> ON | OFF

*RST: OFF for both traces

Example: DISP:TRAC ON
Switches on the display of trace 1 (noise results).
DISP:TRAC:SYMB ON
Switches on the display of symbols for trace 1 (noise results)

Mode: NF

Manual operation: See "Symbols" on page 57
See "Symbols" on page 58

DISPlay[:WINDow<n>]:TRACe<t>:X[:SCALe] <Frequency>

This command selects the frequency to be displayed on the x-axis if the DUT is not an
amplifier, i.e. in a frequency-converting measurement mode.

Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.

Parameters:
<Frequency> IF | RF

*RST: RF

Example: CONF:MODE:DUT DOWN (see [SENSe: ​]CONFigure: ​MODE: ​
DUT​)
The DUT converts the input frequency to a lower output fre-
quency.
DISP:TRAC:X IF
The IF frequency is displayed on x-axis.

Mode: NF

Manual operation: See "X-Axis" on page 58
See "Frequency Axis" on page 60
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DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:AUTO <State>

This command activates or deactivates the automatic scaling of the Y-axis for the
specified trace display. Automatic scaling provides best fit of the Y-axis to the mea-
surement results.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.

Parameters:
<State> ON | OFF

*RST: ON for both traces

Example: DISP:TRAC2 ON (see DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​
SYMBols​)
Switches on the display of trace 2 (gain results).
DISP:TRAC2:Y:AUTO ON
Switches on automatic scaling of the Y-axis for trace 2.

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Automatic Scaling" on page 57
See "Automatic Scaling" on page 58

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:BOTTom <Value>

This command sets the minimum (bottom) Y-axis display value for the specified trace
display. It has no affect if automatic scaling of the Y-axis is enabled (DISPlay[: ​
WINDow<n>]: ​TRACe<t>: ​Y[:​SCALe]: ​AUTO​ command).

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.
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Parameters:
<Value> noise figure: | noise temperature: | gain:

noise figure:
-75 dB to 75 dB
noise temperature:
-999990000 K to 999990000 K
gain:
-75 dB to 75 dB
*RST: 0 dB

Example: DISP:DATA:TRAC1 NFIG
Sets the noise figure to trace1.
DISP:TRAC ON (see DISPlay[: ​WINDow<n>]: ​TRACe<t>: ​
SYMBols​)
Switches on the display of trace 1 (noise results).
DISP:TRAC:Y:BOTT -30
Sets the minimum Y-axis display to -30 dB for trace 1.

Example: DISP:DATA:TRAC1 TEFF
Sets the noise temperature to trace1.
DISP:TRAC ON
Switches on the display of trace 1 (noise results).
DISP:TRAC:Y:BOTT 100
Sets the minimum Y-axis display to 100 K for trace 1.

Example: DISP:TRAC2 ON
Switches on the display of trace 2 (gain results).
DISP:TRAC2:Y:BOTT 1
Sets the minimum Y-axis display to 1 dB for trace 2.

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Min Y-Axis NF/Max Y-Axis NF" on page 57
See "Min Y-Axis Temp/Max Y-Axis Temp" on page 57
See "Min Y-Axis/Max Y-Axis" on page 58

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel <Value>

This command sets the reference level for the Y-axis display value for all trace dis-
plays. This command has no affect if automatic reference level detection is enabled
(DISPlay[:​WINDow<n>]: ​TRACe<t>: ​Y[: ​SCALe]:​RLEVel: ​AUTO​command).

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Suffix: 
<n>

.
1
window

<t> irrelevant
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Parameters:
<Value> *RST: -30 dBm

Example: DISP:TRAC:Y:RLEV 0
Sets the reference level 0 dBm

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Ref Level" on page 51

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel:AUTO <State>

This command enables or disables the automatic reference level detection.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Suffix: 
<n>

.
1
window

<t> irrelevant

Parameters:
<State> ON | OFF

*RST: ON

Example: DISP:TRAC:Y:RLEV:AUTO ON
Turns on automatic reference level detection.

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Automatic Ref Level" on page 51

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:TOP <Value>

This command sets the maximum (top) Y-axis display value for the specified trace dis-
play. It has no affect if automatic scaling of the Y-axis is enabled or the specified trace
is not currently active.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Suffix: 
<n>

.
1
window

<t> 1 | 2
indicates the measurement results: Trace 1 is always used for
noise results, and trace 2 is always used for gain results.
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Parameters:
<Value> noise figure: | noise temperature: | gain:

noise figure:
-75 dB to 75 dB
noise temperature:
-999990000 K to 999990000 K
gain:
-75 dB to 75 dB
*RST: 20 dB for noise and gain figure, 10000K for noise

temperature

Example: DISP:DATA:TRAC1 NFIG
Sets the noise figure to trace1.
DISP:TRAC:Y:TOP 30
Sets the maximum Y-axis display to 30 dB for trace 1.

Example: Example 2
DISP:DATA:TRAC1 TEFF
Sets the noise temperature to trace1.
DISP:TRAC:Y:TOP 100
Sets the maximum Y-axis display to 100 K for trace 1.

Example: DISP:TRAC2:Y:TOP 10
Sets the maximum Y-axis display to 10 dB for trace 2.

Usage: SCPI confirmed

Mode: NF

Manual operation: See "Min Y-Axis NF/Max Y-Axis NF" on page 57
See "Min Y-Axis Temp/Max Y-Axis Temp" on page 57
See "Min Y-Axis/Max Y-Axis" on page 58

8.5 FETCh Subsystem (Noise Figure, K30)

The FETCh subsystem retrieves results for the most recently completed fixed fre-
quency or frequency list measurements. Frequency list results are returned as a list of
results where the result is that requested in the specific fetch command. Single fre-
quency results are single numbers in the described units.

Note:
Corrected measurements are only accessible after a calibration has been performed.

FETCh:ARRay:MEMory<1…3>:NOISe:FIGure?..................................................................96
FETCh:ARRay:MEMory<1…3>:NOISe:GAIN?.................................................................... 96
FETCh:ARRay:MEMory<1…3>:NOISe:TEMPerature?.........................................................96
FETCh:ARRay:NOISE:FIGure?......................................................................................... 96
FETCh:ARRay:NOISE:GAIN?........................................................................................... 96
FETCh:ARRay:NOISE:TEMPerature?................................................................................96
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FETCh:SCALar:NOISE:FIGure?........................................................................................97
FETCh:SCALar:NOISE:GAIN?.......................................................................................... 97
FETCh:SCALar:NOISE:TEMPerature?...............................................................................97

FETCh:ARRay:MEMory<1…3>:NOISe:FIGure?
FETCh:ARRay:MEMory<1…3>:NOISe:GAIN?
FETCh:ARRay:MEMory<1…3>:NOISe:TEMPerature?
This command queries the noise measurement results of the selected memory. The
results are returned as an array of up to 100 elements of noise figure, gain or tempera-
ture results. This command produces an error if no data is held in the selected trace
memory.

Example: INIT
Starts a new measurement, if no measurement sequence is
already in progress.
CONF:ARR:MEM2 ONCE (see CONFigure: ​ARRay:​
MEMory<1…3> ONCE ​ on page 85)
Copies the last recorded measurement result into the memory 2.
FETC:ARR:MEM2:NOIS:TEMP?
Returns an array of 100 noise temperature results from the
selected memory 2.

Usage: Query only

Mode: NF

FETCh:ARRay:NOISE:FIGure?
FETCh:ARRay:NOISE:GAIN?
FETCh:ARRay:NOISE:TEMPerature?
This command queries the last recorded noise figure, gain or temperature measure-
ment results. The results are returned as an array of up to 100 elements of noise
results.

Example: FETCh:ARRay:NOISE:TEMPerature?
Returns an array of up to 100 measured elements associated
with the last noise temperature measurement.

Usage: Query only

Mode: NF

Manual operation: See "Data->Mem1/ Data->Mem2/ Data->Mem3" on page 62
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FETCh:SCALar:NOISE:FIGure?
FETCh:SCALar:NOISE:GAIN?
FETCh:SCALar:NOISE:TEMPerature?
This command queries the last recorded noise figure, gain or temperature measure-
ment result for a fixed frequency measurement. Requires a frequency list measure-
ment to have been performed previously (see CONFigure: ​LIST:​SINGle ​/
CONFigure: ​LIST: ​CONTinuous​ on page 87 or CONFigure: ​FREQ: ​SINGle ​/
CONFigure: ​FREQ: ​CONTinuous​ on page 86).

Example: CONF:LIST:SING
Configures to run a frequency list measurement in single sweep
mode.
INIT
Performs the frequency list measurement.
CONF:SING
Configures to run fixed frequency measurements.
FREQ 10MHz
Sets a fixed frequency of 10 MHz.
FETCh:SCAL:NOISE:TEMPerature?
Returns the last noise temperature measurement at 10 MHz.

Usage: Query only

Mode: NF

8.6 FORMat Subsystem

FORMat:DEXPort:DSEParator <Separator>

This command defines which decimal separator (decimal point or comma) is to be
used for outputting measurement data to the file in ASCII format. Different languages
of evaluation programs (e.g. MS-Excel) can thus be supported.

Parameters:
<Separator> POINt | COMMA

*RST: (factory setting is POINt; *RST does not affect set-
ting)

Example: FORM:DEXP:DSEP POIN
Sets the decimal point as separator.

Manual operation: See "ASCII File Export" on page 63
See "Decim Sep" on page 63
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8.7 INPut Subsystem

INPut:ATTenuation <Value>

This command programs the input attenuator. To protect the input mixer against dam-
age from overloads, the setting 0 dB can be obtained by entering numerals, not by
using the DOWN command.

The attenuation can be set in 5 dB steps (with option R&S FSV-B25: 1 dB steps). If the
defined reference level cannot be set for the set RF attenuation, the reference level is
adjusted accordingly.

In the default state with "Spectrum" mode, the attenuation set on the step attenuator is
coupled to the reference level of the instrument. If the attenuation is programmed
directly, the coupling to the reference level is switched off.

This function is not available if the R&S Digital I/Q Interface (R&S FSV-B17) is active.

Parameters:
<Value> *RST: 10 dB (AUTO is set to ON)

Example: INP:ATT 30dB
Sets the attenuation on the attenuator to 30 dB and switches off
the coupling to the reference level.

Mode: all

Manual operation: See "RF Attenuation" on page 50

INPut:COUPling <CouplingType>

Toggles the RF input of the R&S FSV between AC and DC coupling.

This function is not available if the R&S Digital I/Q Interface (R&S FSV-B17) is active.

Parameters:
<CouplingType> AC | DC

*RST: AC

Example: INP:COUP DC
Manual operation: See "Input (AC/DC)" on page 67

INPut:DIQ:RANGe[:UPPer] <Level>

Defines or queries the "Full Scale Level", i.e. the level that should correspond to an I/Q
sample with the magnitude "1".

It can be defined either in dBm or Volt (see "Full Scale Level" on page 52).

This command is only available if the optional R&S Digital I/Q Interface (option
R&S FSV-B17) is installed.

For details see the R&S Digital I/Q Interface (R&S FSV-B17) description of the base
unit.
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Parameters:
<Level> <numeric value>

Range: 70.711 nV  to  7.071 V
*RST: 1 V

Example: INP:DIQ:RANG 1V
Mode: A, IQ, NF, TDS, VSA, CDMA, EVDO, WCDMA, ADEMOD,

GSM, OFDM, OFDMA/WiBro, WLAN

Manual operation: See "Full Scale Level" on page 52

INPut:DIQ:SRATe <SampleRate>

This command specifies or queries the sample rate of the input signal from the R&S
Digital I/Q Interface (see "Input Sample Rate" on page 52).

This command is only available if the optional R&S Digital I/Q Interface (option
R&S FSV-B17) is installed.

For details see the R&S Digital I/Q Interface (R&S FSV-B17) description of the base
unit.

Parameters:
<SampleRate> Range: 1 Hz  to  10 GHz

*RST: 32 MHz

Example: INP:DIQ:SRAT 200 MHz

Mode: A, IQ, NF, TDS, VSA, CDMA, EVDO, WCDMA, ADEMOD,
GSM, OFDM, OFDMA/WiBro, WLAN

Manual operation: See "Input Sample Rate" on page 52

INPut:GAIN:STATe <State>

This command turns the 20 dB preamplifier on and off.

With option R&S FSV-B22, the preamplifier only has an effect below 7 GHz.

With option R&S FSV-B24, the amplifier applies to the entire frequency range.

This command is not available when using R&S Digital I/Q Interface (R&S FSV-B17).

Parameters:
<State> ON | OFF

*RST: OFF

Example: INP:GAIN:STAT ON
Turns the preamplifier on.

Manual operation: See "Preamp On/Off" on page 51
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INPut:SELect <Source>

This command selects the signal source for measurements.

Parameters:
<Source> RF | DIQ

RF
Radio Frequency ("RF INPUT" connector)
DIQ
Digital IQ (only available with R&S Digital I/Q Interface, option
R&S FSV-B17)
*RST: RF

Example: INP:SEL RF

Mode: A, IQ, NF, TDS, VSA, CDMA, EVDO, WCDMA, ADEMOD,
GSM, OFDM, OFDMA/WiBro, WLAN

Manual operation: See "Input" on page 52

8.8 INITiate Subsystem

INITiate<n>:CONTinuous <State>

This command determines whether the trigger system is continuously initiated (contin-
uous) or performs single measurements (single).

In R&S FSV-K30, the measurement is not started by this command,
INITiate:IMMediate has to be used to start a measurement.

Suffix: 
<n>

.
irrelevant

Parameters:
<State> ON | OFF

*RST: ON

Example: INIT:CONT OFF
Switches the sequence to single sweep.
INIT:CONT ON
Switches the sequence to continuous sweep.
INIT:IMM
Starts a new noise figure measurement in continuous sweep
mode.

Mode: all

Manual operation: See "Continuous sweep" on page 61
See "Sweep Single" on page 61
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8.9 INSTrument Subsystem (Noise Figure, R&S FSV-K30)

The INSTrument subsystem selects the operating mode of the unit either via text
parameters or fixed numbers.

INSTrument[:SELect]......................................................................................................101
INSTrument:NSELect..................................................................................................... 101

INSTrument[:SELect] <Mode>

This command switches between the measurement modes by means of text parame-
ters.

Parameters:
<Mode> NOISe

Noise Figure Measurements option, R&S FSV-K30

INSTrument:NSELect <Mode>

This command switches between the measurement modes by means of numbers.

Parameters:
<Mode> 19

Noise Figure Measurements option, R&S FSV-K30

8.10 SENSe Subsystem (Noise Figure, R&S FSV-K30)

The SENSe subsystem is used to set and query the values of parameters in the
remote instrument.

:DEFault If a parameter has a default a value, the command parameter can be substitu-
ted with:DEFault which loads the default (reset) value of the parameter.

:UP/DOWN In addition, all numeric values are able to take:UP or:DOWN in place of the
parameter. This will increment or decrement the numeric value.

:MIN/MAX In addition, all numeric values are able to take either:MINimum or:MAXimum as
arguments to determine the minimum or maximum range available for the com-
mand.

The SENSe subsystem is divided into equipment settings and measurement settings.

8.10.1 Equipment Settings Commands..................................................................................102

8.10.2 Measurement Settings (SENSe:CONFigure) Commands ......................................... 107
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8.10.1 Equipment Settings Commands

[SENSe:]CORRection[:STATe]........................................................................................102
[SENSe:]CORRection:ENR:MODE.................................................................................. 102
[SENSe:]CORRection:ENR:SPOT................................................................................... 103
[SENSe:]CORRection:ENR[:MEASurement]:TABLe:DATA.................................................103
[SENSe:]CORRection:IREJection.................................................................................... 103
[SENSe:]CORRection:LOSS:INPut:MODE........................................................................104
[SENSe:]CORRection:LOSS:INPut:SPOT........................................................................ 104
[SENSe:]CORRection:LOSS:INPut:TABLe....................................................................... 105
[SENSe:]CORRection:LOSS:OUTPut:MODE....................................................................105
[SENSe:]CORRection:LOSS:OUTPut:SPOT.....................................................................106
[SENSe:]CORRection:LOSS:OUTPut:TABLe....................................................................106
[SENSe:]CORRection:TEMPerature.................................................................................107

[SENSe:]CORRection[:STATe] <State>

This command activates or deactivates the second stage correction.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CORR ON
Activates the second stage correction.

Mode: NF

Manual operation: See "2nd Stage Correction" on page 49

[SENSe:]CORRection:ENR:MODE <Mode>

This command specifies whether a constant ENR value applies for all measured fre-
quencies or an ENR table (ENR values specified at specific input frequencies). The
constant ENR value is specified by the [SENSe: ​]CORRection: ​ENR: ​SPOT​ command.

Parameters:
<Mode> TABLe | SPOT

TABLe
ENR table is used.
SPOT
Constant ENR value is used.
*RST: SPOT

Example: CORR:ENR:MODE SPOT
Uses the configured constant ENR value for all measured fre-
quencies.

Mode: NF
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[SENSe:]CORRection:ENR:SPOT <Value>

This command sets the constant ENR value of the noise source that is used through-
out the entire frequency range.

Parameters:
<Value> -999.99 to 999.99 dB

*RST: 15 dB

Example: CORR:ENR:MODE SPOT, see [SENSe: ​]CORRection: ​ENR:​
MODE​ on page 102
Uses the configured constant ENR value for all measured fre-
quencies.
CORR:ENR:SPOT 30
Sets the constant ENR value to 30 dB for all input frequencies to
be measured.

Mode: NF

Manual operation: See "Selection" on page 46
See "ENR Constant" on page 47

[SENSe:]CORRection:ENR[:MEASurement]:TABLe:DATA <TableData>

This command specifies a new ENR table to determine the correct ENR (excess noise
ratio) figure to be used for the input frequencies. This new list completely overwrites all
current ENR frequency list entries regardless of how many entries are present and how
many entries are being supplied for the new list.

Parameters:
<TableData> numeric value = a frequency ENR pair of arguments

frequency: 0 Hz to 999.99 GHz.
ENR figure: -999.99 to 999.99 (value in dB, accurate to two deci-
mal places)

Example: CORR:ENR:MODE TABL, see [SENSe: ​]CORRection: ​ENR: ​
MODE​ on page 102
Uses the ENR table.
CORR:ENR:MEAS:TABL:DATA 1MHZ,10,2MHZ,12
Specifies a new ENR table and overwrites the current ENR table
with the two entry pairs specified.

Mode: NF

Manual operation: See "ENR Settings" on page 46

[SENSe:]CORRection:IREJection <Value>

This command specifies an image rejection value for the selected DUT ([SENSe: ​
]CONFigure: ​MODE:​DUT​ command) which will be effective throughout the entire fre-
quency range.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).
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Parameters:
<Value> Range: 0 dB  to  999.99 dB

*RST: 999.99 dB

Example: [SENSe: ​]CONFigure: ​MODE:​DUT ​ CONF:MODE:DUT DOWN
The DUT converts the input frequency to a lower output fre-
quency.
CORR:IREJ 100
Sets an image rejection value of 100 dB.

Mode: NF

Manual operation: See "Image Rej" on page 45

[SENSe:]CORRection:LOSS:INPut:MODE <Mode>

This command specifies whether a constant input loss value applies for all measured
frequencies or an input loss list (loss input values specified at specific input frequen-
cies). The constant loss input value is specified by the [SENSe:​]CORRection: ​LOSS: ​
INPut: ​SPOT​ command.

Parameters:
<Mode> SPOT | TABLe

SPOT
The constant loss input value for all measurement frequencies is
used.
TABLe
The loss input table is used.
*RST: SPOT

Example: CORR:LOSS:INP:MODE SPOT
Uses the configured constant loss input value for all input fre-
quencies to be measured.

Mode: NF

Manual operation: See "Selection" on page 48

[SENSe:]CORRection:LOSS:INPut:SPOT <Value>

This command specifies the loss input constant for all input frequencies to be mea-
sured.

Parameters:
<Value> -999.99 to 999.99 dB, accurate to two decimal places

*RST: 0 dB

SENSe Subsystem (Noise Figure, R&S FSV-K30)



Remote Control CommandsR&S® FSV-K30

105Operating Manual 1176.7562.02 ─ 02

Example: [SENSe: ​]CONFigure: ​MODE:​DUT ​ CORR:LOSS:INP:MODE
SPOT
Uses the configured constant loss input value for all input fre-
quencies to be measured.
CORR:LOSS:INP:SPOT 10
Sets the internal input loss constant value to 10 dB for all input
frequencies to be measured.

Mode: NF

Manual operation: See "Loss Input Constant/Loss Output Constant" on page 48

[SENSe:]CORRection:LOSS:INPut:TABLe <TableData>

This command specifies a new input loss table to determine the correct input loss to be
used for the input frequencies. This new list completely overwrites all current input loss
list entries regardless of how many entries are present and how many entries are being
supplied for the new list.

Parameters:
<TableData> <numeric_value>,<numeric_value> = a frequency loss pair of

arguments
frequency: 0 Hz to 999.99 GHz (max. two decimal places)
loss figure: -999.99 to 999.99 (value in dB, accurate to two deci-
mal places)

Example: [SENSe: ​]CONFigure: ​MODE:​DUT ​ CORR:LOSS:INP:MODE
TABL
Uses the loss input table.
CORR:LOSS:INP:TABL 1MHz,10,2MHz,12
Specifies a new input loss table and overwrites the current input
loss table with the two entry pairs specified.

Mode: NF

Manual operation: See "Loss Settings" on page 47
See "Selection" on page 48

[SENSe:]CORRection:LOSS:OUTPut:MODE <Mode>

This command specifies whether a constant output loss value applies for all measured
frequencies or an output loss list (loss output values specified at specific input frequen-
cies). The constant loss output value is specified by the [SENSe:​]CORRection: ​
LOSS: ​OUTPut:​SPOT ​ command.
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Parameters:
<Mode> SPOT | TABLe

SPOT
The constant loss input value for all measurement frequencies is
used.
TABLe
The loss input table is used.
*RST: SPOT

Example: CORR:LOSS:OUTP:MODE SPOT
Uses the configured constant loss output value for all input fre-
quencies to be measured.

Mode: NF

[SENSe:]CORRection:LOSS:OUTPut:SPOT <Value>

This command specifies the loss output constant for all input frequencies to be mea-
sured.

Parameters:
<Value> -999.99 to 999.99 dB, accurate to two decimal places

*RST: 0 dB

Example: [SENSe: ​]CORRection: ​ENR:​SPOT ​ on page 103
CORR:LOSS:OUTP:MODE SPOT
Uses the configured constant loss output value for all input fre-
quencies to be measured.
CORR:LOSS:OUTP:SPOT 10
Sets the internal output loss constant value to 10 dB for all input
frequencies to be measured.

Mode: NF

Manual operation: See "Loss Input Constant/Loss Output Constant" on page 48

[SENSe:]CORRection:LOSS:OUTPut:TABLe <TableData>

This command specifies a new output loss table to determine the correct output loss to
be used for the input frequencies. This new list completely overwrites all current output
loss list entries regardless of how many entries are present and how many entries are
being supplied for the new list.

Parameters:
<TableData> <numeric_value>,<numeric_value> = a frequency loss pair of

arguments
frequency: 0 Hz to 999.99 GHz (max. two decimal places)
loss figure: -999.99 to 999.99 (value in dB, accurate to two deci-
mal places)
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Example: [SENSe: ​]CORRection: ​ENR:​SPOT ​ on page 103
CORR:LOSS:OUTP:MODE TABL
Uses the loss output table.
CORR:LOSS:OUTP:TABL 1MHz,10,2MHz,12
Specifies a new output loss table and overwrites the current out-
put loss table with the two entry pairs specified.

Mode: NF

Manual operation: See "Loss Settings" on page 47

[SENSe:]CORRection:TEMPerature <Temperature>

This command specifies the room temperature of the operating environment. This
value is taken into account when calculating noise results.

Parameters:
<Temperature> 278.15 to 318.15 K; up to 2 decimal places can be specified.

*RST: 293 K

Example: CORR:TEMP 291.50
Specifies the room temperature to 291.50 Kelvin (18.5 C).

Mode: NF

Manual operation: See "Room Temperature" on page 47

8.10.2 Measurement Settings (SENSe:CONFigure) Commands

Most parameters for the measurements are set using the SENSe:CONFigure com-
mands described here.

Some additional measurement settings are defined using the SENSe:FREQuency sub-
system, see chapter 8.10, "SENSe Subsystem (Noise Figure, R&S FSV-K30)",
on page 101.

[SENSe:]BANDwidth|BWIDth[:RESolution]....................................................................... 108
[SENSe:]CONFigure:MODE:DUT.................................................................................... 108
[SENSe:]CONFigure:MODE:SYSTem:IF:FREQuency........................................................109
[SENSe:]CONFigure:MODE:SYSTem:LOSCillator.............................................................109
[SENSe:]CONFigure:MODE:SYSTem:LOSCillator:FREQuency.......................................... 110
[SENSe:]FREQuency[:CW|:FIXed]...................................................................................110
[SENSe:]FREQuency:CENTer.........................................................................................111
[SENSe:]FREQuency:LIST:DATA.................................................................................... 111
[SENSe:]FREQuency:SPAN............................................................................................112
[SENSe:]FREQuency:STARt...........................................................................................112
[SENSe:]FREQuency:STEP............................................................................................112
[SENSe:]FREQuency:STOP............................................................................................112
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[SENSe:]SWEep:COUNt.................................................................................................113
[SENSe:]SWEep:POINts.................................................................................................113
[SENSe:]SWEep:TIME................................................................................................... 113

[SENSe:]BANDwidth|BWIDth[:RESolution] <Bandwidth>

This command defines the resolution bandwidth.

The available resolution bandwidths are specified in the data sheet. For details on the
correlation between resolution bandwidth and filter type refer to chapter 3.7, "Selecting
the Appropriate Filter Type", on page 18.

Parameters:
<Bandwidth> refer to data sheet

*RST: (AUTO is set to ON)

Example: BAND 1 MHz
Sets the resolution bandwidth to 1 MHz

Manual operation: See "RBW" on page 49

[SENSe:]CONFigure:MODE:DUT <Type>

This command defines the type of DUT. This setting determines the method that is
used to create the frequency measurement list.

For Fixed LO or Fixed IF measurements, the [SENSe: ​]CONFigure: ​MODE: ​SYSTem:​
LOSCillator ​ command is also required.

Fixed local oscillator frequencies are taken from the settings supplied by [SENSe:​
]CONFigure: ​MODE:​SYSTem: ​LOSCillator: ​FREQuency ​ on page 110.

Fixed IF frequencies are taken from the settings supplied by [SENSe: ​]CONFigure: ​
MODE: ​SYSTem: ​IF:​FREQuency ​ on page 109.

Parameters:
<Type> AMPLifier | DOWNconv | UPConv | DDOWnconverter

AMPLifier
The DUT is an amplifier and not a frequency converting device.
DOWNconv
The DUT converts the input frequency to a lower output fre-
quency:
Fixed LO, IF=RF+LO
UPConv
The DUT converts the input frequency to a higher output fre-
quency:
Fixed LO, IF=abs(RF-LO).
DDOWnconverter
The DUT provides digital input via the digital baseband interface
(R&S FSV-B17 option)
*RST: AMPLifier
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Example: SENS:CONF:MODE:DUT DOWN
The DUT converts the input frequency to a lower output fre-
quency.

Mode: NF

Manual operation: See "Mode" on page 44

[SENSe:]CONFigure:MODE:SYSTem:IF:FREQuency <Frequency>

This remote control command specifies a fixed intermediate frequency for a new fre-
quency measurement list that requires computing.

The command does not have any immediate effect if a direct frequency list is being
used which is set by the remote control command SENS:CONF:MODE:DUT AMPL (see
[SENSe: ​]CONFigure: ​MODE:​DUT ​ on page 108) or a variable intermediate frequency
has been specified (set by the SENS:CONF:MODE:SYST:LOSC FIX command, see
[SENSe: ​]CONFigure: ​MODE:​SYSTem: ​LOSCillator ​ on page 109).

This command is only available if the R&S FSV-B10 option (External Generator) is
installed.

Parameters:
<Frequency> Range: 0 Hz  to  999.99 GHz

*RST: - 0 Hz

Example: The DUT converts the input frequency to a lower output fre-
quency.
SENS:CONF:MODE:SYST:IF:FREQ 500KHZ
Sets the fixed intermediate frequency for a new list, yet to be
created, to a value of 500 kHz.

Mode: NF

Manual operation: See "Fixed IF" on page 45
See "LO/IF" on page 60

[SENSe:]CONFigure:MODE:SYSTem:LOSCillator <Mode>

This remote control command specifies whether the local oscillator is used as a fixed
frequency source or a variable frequency source. The command does not have any
immediate effect if a direct frequency list is being used which is set by the remote con-
trol command SENS:CONF:MODE:DUT AMPL (see [SENSe: ​]CONFigure: ​MODE:​DUT​
on page 108).

This command is only available if the R&S FSV-B10 option (External Generator) is
installed.
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Parameters:
<Mode> FIXed | VARiable

FIXed
Local Oscillator is used as a fixed frequency source.
VARiable
Local Oscillator is used as a variable frequency source.

Mode: NF

Manual operation: See "Mode" on page 44

[SENSe:]CONFigure:MODE:SYSTem:LOSCillator:FREQuency <Frequency>

This command specifies a fixed local oscillator frequency for a new frequency mea-
surement list in frequency-converting measurement mode. If this value is altered, a
new frequency list is generated.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

Parameters:
<Frequency> Range: 0 Hz  to  999.99 GHz

*RST: - 0 Hz

Example: [SENSe: ​]CONFigure: ​MODE:​DUT ​ on page 108
SENS:CONF:MODE:DUT DOWN
The DUT converts the input frequency to a lower output fre-
quency.
SENS:CONF:MODE:SYST:LOSC:FREQ 1MHZ
Specifies the fixed local oscillator frequency for a new list to a
value of 1 MHz.

Mode: NF

Manual operation: See "Fixed LO" on page 45
See "LO/IF" on page 60

[SENSe:]FREQuency[:CW|:FIXed] <Frequency>

This command specifies a fixed frequency to measure noise and gain continuously
(fixed frequency measurement).

Parameters:
<Frequency> <numeric value>

*RST: 550 MHz

Example: CONF:SING
Configures to run fixed frequency measurements.
FREQ 10MHz
Sets a fixed frequency of 10 MHz.

Usage: SCPI confirmed

Mode: NF
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Manual operation: See "Fix Freq" on page 62

[SENSe:]FREQuency:CENTer <Frequency>

This command defines the center frequency (frequency domain) or measuring fre-
quency (time domain).

Parameters:
<Frequency> Range: 0  to  fmax

*RST: fmax/2
Default unit: Hz
fmax is specified in the data sheet. min span is 10 Hz

Example: FREQ:CENT 100 MHz
Manual operation: See "Center Freq" on page 44

See "Center Freq" on page 59

[SENSe:]FREQuency:LIST:DATA <FrequencyList>

This command specifies a new frequency list (for frequency list measurement). Each
list entry consists of three separate frequency entities: a receive frequency (RF), a
local oscillator frequency (LO), and an intermediate frequency (IF). The new list com-
pletely overwrites all the current frequency list entries regardless of how many entries
are present and how many entries are being supplied for the new list. The new list is
the active list until a new list is automatically created.

The values specified in this command are not used for a fixed frequency measurement
(CONFigure: ​SINGle​ command).

Parameters:
<FrequencyList> direct measurement | frequency-converting measurement

direct measurement
RF: 0 Hz to fmax
frequency-converting measurement
RF, LO: 0 Hz to 999.99 GHz
IF: 0 Hz to fmax
*RST: 550 MHz | 0 Hz | 550 MHz
<numeric_value>,<numeric_value>, … (max. of 100 argument)
numeric value = set of three frequency measurements in the fol-
lowing order: fixed frequency, local oscillator frequency, and
intermediate frequency. The frequency range depends on the
selected measurement mode:

Example: FREQ:LIST:DATA 550MHz,300MHz,900MHz
Specifies one entry frequency list with a receive frequency of
550 MHz, a local oscillator frequency of 300 MHz, and an inter-
mediate frequency of 900 MHz.

Mode: NF

Manual operation: See "Frequency Table" on page 45
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[SENSe:]FREQuency:SPAN <Span>

This command defines the frequency span.

Parameters:
<Span> min span to fmax

*RST: fmax
fmax is specified in the data sheet. min span is 10 Hz

Example: FREQ:SPAN 10MHz
Manual operation: See "Span" on page 44

See "Span" on page 60

[SENSe:]FREQuency:STARt <Frequency>

This command specifies the start frequency for a new frequency measurement list. If
this value is altered, a new frequency list is generated.

Parameters:
<Frequency> 0 to (fmax - min span)

*RST: 0
fmax is specified in the data sheet. min span is 10 Hz

Example: FREQ:STAR 20MHz
Manual operation: See "Start Freq" on page 43

See "Start" on page 59

[SENSe:]FREQuency:STEP <Frequency>

This command specifies the step frequency for a new frequency measurement list. If
this value is altered, a new frequency list is generated.

Parameters:
<Frequency> <numeric value>

*RST: 32 MHz

Example: FREQ:STEP 10MHZ
Sets the step frequency for a new list to a value of 10 MHz.

Manual operation: See "Step Freq" on page 44
See "Stepsize" on page 59

[SENSe:]FREQuency:STOP <Frequency>

This command specifies the stop frequency for a new frequency measurement list. If
this value is altered, a new frequency list is generated.
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Parameters:
<Frequency> min span to fmax

*RST: fmax
fmax is specified in the data sheet. min span is 10 Hz

Example: FREQ:STOP 2000 MHz
Manual operation: See "Stop Freq" on page 43

See "Stop" on page 60

[SENSe:]SWEep:COUNt <NumberSweeps>

This command defines the number of sweeps started with single sweep, which are
used for calculating the average or maximum value. If the values 0 or 1 are set, one
sweep is performed.

Parameters:
<NumberSweeps> 0 to 32767

*RST: 0 (GSM: 200, PHN:1)

Example: SWE:COUN 64
Sets the number of sweeps to 64.
INIT:CONT OFF
Switches to single sweep mode.
INIT;*WAI
Starts a sweep and waits for its end.

Manual operation: See "Average" on page 50

[SENSe:]SWEep:POINts <NumberPoints>

This command defines the number of measurement points to be collected during one
sweep.

Parameters:
<NumberPoints> Range: 2  to  100

*RST: 11

Example: SWE:POIN 251
Manual operation: See "Sweep points" on page 44

See "Sweep points" on page 60

[SENSe:]SWEep:TIME <Time>

This command defines the sweep time.

The range depends on the frequency span.

Parameters:
<Time> refer to data sheet

*RST: (automatic)
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Example: SWE:TIME 10s
Manual operation: See "Sweep Time" on page 50

8.11 SOURce Subsystem

SOURce<n>:EXTernal<generator>:FREQuency[:FACTor]:DENominator.............................114
SOURce<n>:EXTernal<generator>:FREQuency[:FACTor]:NUMerator.................................114
SOURce<n>:EXTernal<generator>:FREQuency:OFFSet<m>.............................................115
SOURce<n>:EXTernal<generator>:POWer[:LEVel]...........................................................116
SOURce<n>:EXTernal<generator>:ROSCillator[:SOURce]................................................ 116

SOURce<n>:EXTernal<generator>:FREQuency[:FACTor]:DENominator <Value>

This command defines the denominator of the factor with which the analyzer frequency
is multiplied in order to obtain the transmit frequency of the selected generator.

This command is only valid for R&S FSV option External Tracking Generator
(R&S FSV-B10).

Select the multiplication factor such that the frequency range of the generator is not
exceeded if the following formula is applied to the start and stop frequency of the ana-
lyzer:

OffsetAnalyzerGenerator F
atorDeno

NumeratorFF 
min

Suffix: 
<n>

.
irrelevant

<generator> 1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Value> <numeric value>

*RST: 1

Example: SOUR:EXT:FREQ:NUM 4"
"SOUR:EXT:FREQ:DEN 3"
Sets a multiplication factor of 4/3, i.e. the transmit frequency of
the generator is 4/3 times the analyzer frequency.

Mode: A, NF

Manual operation: See "Offset 1 / Factor 1 / Factor 2 / Offset 2" on page 54

SOURce<n>:EXTernal<generator>:FREQuency[:FACTor]:NUMerator <Value>

This command defines the numerator of the factor with which the analyzer frequency is
multiplied in order to obtain the transmit frequency of the selected generator.
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This command is only valid for R&S FSV option External Tracking Generator
(R&S FSV-B10).

Select the multiplication factor such that the frequency range of the generator is not
exceeded if the following formula is applied to the start and stop frequency of the ana-
lyzer:

OffsetAnalyzerGenerator F
atorDeno

NumeratorFF 
min

Suffix: 
<n>

.
irrelevant

<generator> 1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Value> <numeric value>

*RST: 1

Example: SOUR:EXT:FREQ:NUM 4"
"SOUR:EXT:FREQ:DEN 3"
Sets a multiplication factor of 4/3, i.e. the transmit frequency of
the generator is 4/3 times the analyzer frequency.

Mode: A, NF

Manual operation: See "Offset 1 / Factor 1 / Factor 2 / Offset 2" on page 54

SOURce<n>:EXTernal<generator>:FREQuency:OFFSet<m> <Offset>

This command defines the frequency offset of the selected generator with reference to
the receive frequency.

This command is only valid for R&S FSV option External Tracking Generator
(R&S FSV-B10).

Suffix: 
<n>

.
irrelevant

<generator> 1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

<m> 1 | 2
offset (for Noise Figure measurements (K30) only)
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Parameters:
<Offset> <numeric value>, specified in Hz, kHz, MHz or GHz, rounded to

the nearest Hz
*RST: 0 Hz
Select the multiplication factor such that the frequency range of
the generator is not exceeded if the following formula is applied
to the start and stop frequency of the analyzer:

For Noise Figure measurements (R&S FSV-K30), the following
formula applies:
Generator Frequency = [(LO + Offset 1) * Factor 1 / Factor 2)] +
Offset 2

Example: SOUR:EXT:FREQ:OFFS 1GHZ
Sets a frequency offset of the generator transmit frequency com-
pared to the analyzer receive frequency of 1 GHz.

Mode: A, NF

Manual operation: See "Offset 1 / Factor 1 / Factor 2 / Offset 2" on page 54

SOURce<n>:EXTernal<generator>:POWer[:LEVel] <Level>

This command sets the output power of the selected generator.

This command is only valid for R&S FSV option External Tracking Generator
(R&S FSV-B10).

Suffix: 
<n>

.
irrelevant

<generator> 1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Level> <numeric value>

*RST: -20 dBm

Example: SOUR:EXT:POW -30dBm
Sets the generator level to -30 dBm

Mode: A, NF

Manual operation: See "Source Power" on page 53

SOURce<n>:EXTernal<generator>:ROSCillator[:SOURce] <Source>

This command controls selection of the reference oscillator for the external tracking
generator (requires option R&S FSV-B10).

If the external reference oscillator is selected, the reference signal must be connected
to the rear panel of the instrument.

SOURce Subsystem
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Suffix: 
<n>

.
irrelevant

<generator> 1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Source> INTernal

the internal reference is used
EXTernal
the external reference is used; if none is available, an error flag
is displayed in the status bar
*RST: INT

Example: SOUR:EXT:ROSC EXT
Switches to external reference oscillator

Mode: A, NF

Manual operation: See "Reference" on page 54

8.12 STATus Subsystem (Noise Figure, R&S FSV-K30)

The STATus subsystem contains the commands for the status reporting system (See
part "). *RST does not influence the status registers.

STATus:QUEStionable:CORRection[:EVENt]?..................................................................117
STATus:QUEStionable:CORRection:CONDition?..............................................................117
STATus:QUEStionable:CORRection:ENABle....................................................................118
STATus:QUEStionable:CORRection:NTRansition............................................................. 118
STATus:QUEStionable:CORRection:PTRansition............................................................. 118

STATus:QUEStionable:CORRection[:EVENt]?

This command queries the contents of the EVENt part of the STATus:QUEStiona-
ble:CORRection register. Readout deletes the contents of the EVENt part.

Example: STAT:QUES:CORR?
Usage: Query only

SCPI confirmed

Mode: NF

STATus:QUEStionable:CORRection:CONDition?

This command queries the contents of the CONDition part of the STATus:QUEStiona-
ble:CORRection register. Readout does not delete the contents of the CONDition part.

Example: STAT:QUES:CORR:COND?
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Usage: Query only
SCPI confirmed

Mode: NF

STATus:QUEStionable:CORRection:ENABle <BitDefinition>

This command sets the bits of the ENABle part of the STATus:QUEStionable:COR-
Rection register. The ENABle register selectively enables the individual events of the
associated EVENt part for the summary bit.

Parameters:
<BitDefinition> Range: 0  to  65535

Example: STAT:QUES:CORR:ENAB 65535
All events bits are represented in the CORRection summary bit.

Usage: SCPI confirmed

Mode: NF

STATus:QUEStionable:CORRection:NTRansition <BitDefinition>

This command determines what bits in the STATus:QUEStionable:CORRection Condi-
tion register set the corresponding bit in the STATus:QUEStionable:CORRection Event
register if that bit has a negative transition (1 to 0). The variable <number> is the sum
of the decimal values of the bits that are to be enabled.

Parameters:
<BitDefinition> Range: 0  to  65535

Example: STAT:QUES:CORR:NTR 65535
All condition bits are summarized in the Event register if a posi-
tive transition occurs.

Usage: SCPI confirmed

Mode: NF

STATus:QUEStionable:CORRection:PTRansition <BitDefinition>

This command determines what bits in the STATus:QUEStionable:CORRection Condi-
tion register set the corresponding bit in the STATus:QUEStionable:CORRection Event
register if that bit has a positive transition (0 to 1). The variable <number> is the sum of
the decimal values of the bits that are to be enabled.

Parameters:
<BitDefinition> Range: 0  to  65535

Example: STAT:QUES:CORR:PTR 65535
All condition bits are summarized in the Event register if a posi-
tive transition occurs.

Usage: SCPI confirmed

STATus Subsystem (Noise Figure, R&S FSV-K30)
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Mode: NF

8.13 SYSTem Subsystem (Noise Figure, R&S FSV-K30)

This subsystem contains a series of commands for general functions.

SYSTem:COMMunicate:GPIB:RDEVice:GENerator<generator>:ADDRess..........................119
SYSTem:COMMunicate:RDEVice:GENerator<generator>:INTerface.................................. 119
SYSTem:COMMunicate:RDEVice:GENerator<generator>:LINK..........................................120
SYSTem:COMMunicate:RDEVice:GENerator<generator>:TYPE........................................ 121
SYSTem:COMMunicate:TCPip:RDEVice:GENerator<generator>:ADDRess.........................121
SYSTem:CONFigure:DUT:GAIN......................................................................................121
SYSTem:CONFigure:DUT:STIMe.................................................................................... 122
SYSTem:CONFigure:GENerator:CONTrol:STATe.............................................................122
SYSTem:CONFigure:GENerator:INITialise:IMMediate....................................................... 123
SYSTem:CONFigure:GENerator:INITialise:AUTO............................................................. 123
SYSTem:CONFigure:GENerator:SWITch:AUTO............................................................... 123

SYSTem:COMMunicate:GPIB:RDEVice:GENerator<generator>:ADDRess
<Number>

Changes the IEC/IEEE-bus address of the external tracking generator.

This command is only available if the R&S FSV option B10 (External Tracking Genera-
tor) is installed.

Suffix: 
<generator>

.
1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Number> Range: 0  to  30

*RST: 28

Example: SYST:COMM:GPIB:RDEV:GEN1:ADDR 15
Mode: A, NF

SYSTem:COMMunicate:RDEVice:GENerator<generator>:INTerface <Type>

Defines the interface used for the connection to the external tracking generator.

This command is only available if the R&S FSV option B10 (External Tracking Genera-
tor) is installed.

Suffix: 
<generator>

.
1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only
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Parameters:
<Type> GPIB | TCPip

*RST: GPIB

Example: SYST:COMM:RDEV:GEN1:INT TCP
Mode: A, NF

Manual operation: See "Interface" on page 53

SYSTem:COMMunicate:RDEVice:GENerator<generator>:LINK <Type>

This command selects the link type of the external generator if the GPIB interface is
used.

The difference between the two GPIB operating modes is the execution speed. While,
during GPIB operation, each frequency to be set is transmitted to the generator sepa-
rately, a whole frequency list can be programmed in one go if the TTL interface is also
used. Frequency switching can then be performed per TTL handshake which results in
considerable speed advantages.

Notes: Only one of the two generators can be operated via the TTL interface at a time.
The other generator must be configured via GPIB.

For Noise Figure measurements (K30), TTL synchronization has no effect.

This command is only available if the R&S FSV option B10 (External Tracking Genera-
tor) is installed.

Suffix: 
<generator>

.
1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Type> GPIB | TTL

GPIB
GPIB connection without TTL synchronization (for all generators
of other manufacturers and some Rohde & Schwarz devices)
TTL
GPIB connection with TTL synchronization (if available; for most
Rohde&Schwarz devices)
*RST: GPIB

Example: SYST:COMM:RDEV:GEN:LINK TTL
Selects GPIB + TTL interface for generator operation.

Mode: A, NF

Manual operation: See "TTL Synchronization" on page 53
See "Address" on page 53

SYSTem Subsystem (Noise Figure, R&S FSV-K30)
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SYSTem:COMMunicate:RDEVice:GENerator<generator>:TYPE <Name>

This command selects the type of external generator. For a list of the available genera-
tor types including the associated interface, see chapter 3.10, "Overview of Generators
Supported by the R&S FSV", on page 22.

If no external generator type is currently configured, the query returns "NONE".

This command is only available if the R&S FSV option B10 (External Tracking Genera-
tor) is installed.

Suffix: 
<generator>

.
1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Name> Generator name | NONE

*RST: NONE

Example: SYST:COMM:RDEV:GEN2:TYPE 'SME02'
Selects SME02 as generator 2

Mode: A, NF

Manual operation: See "Type" on page 53

SYSTem:COMMunicate:TCPip:RDEVice:GENerator<generator>:ADDRess
<Address>

Configures the TCP/IP address for the external tracking generator 1 or 2.

This command is only available if the R&S FSV option B10 (External Tracking Genera-
tor) is installed.

Suffix: 
<generator>

.
1 | 2
tracking generator
For Noise Figure measurements (K30): 1 only

Parameters:
<Address> TCP/IP address between 0.0.0.0 and 0.255.255.255

*RST: 0.0.0.0

Example: SYST:COMM:TCP:RDEV:GEN1:ADDR 130.094.122.195
Mode: A

SYSTem:CONFigure:DUT:GAIN <Gain>

This command specifies the maximum gain of the DUT.

This command is not available when using Digital Baseband Interface (R&S FSV-B17).

SYSTem Subsystem (Noise Figure, R&S FSV-K30)
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Parameters:
<Gain> Range: 10 dB  to  999.99 dB

*RST: 30 dB

Example: SYST:CONF:DUT:GAIN 10
Specifies the gain of the DUT to be 10 dB.

Mode: NF

Manual operation: See "Range" on page 51

SYSTem:CONFigure:DUT:STIMe <Time>

This command spcifies the DUT settling time. It represents the time to wait for the DUT
to settle after a noise source has been turned on or off.

Parameters:
<Time> Range: 0  to  20 s

*RST: 50 milliseconds

Example: SYST:CONF:DUT:STIM 1000MS
Specifies a period of one second for the DUT to settle down
after exposure to the noise source has been removed.

Mode: NF

Manual operation: See "Settling Time" on page 50

SYSTem:CONFigure:GENerator:CONTrol:STATe <State>

This remote control command specifies whether the setup of the external generator is
to be automatically controlled by the R&S FSV-K30 option (via GPIB) or manually by
the user.

Parameters:
<State> ON | OFF

ON
Setup controlled by the tracking generator.
OFF
Setup controlled manually by the user.
*RST: OFF

Example: SYST:CONF:GEN:CONT:STAT ON
The R&S FSV-K30 option completely controls the setting of the
external signal generator.

Mode: NF

Manual operation: See "Automatic Control" on page 52

SYSTem Subsystem (Noise Figure, R&S FSV-K30)



Remote Control CommandsR&S® FSV-K30

123Operating Manual 1176.7562.02 ─ 02

SYSTem:CONFigure:GENerator:INITialise:IMMediate

This remote control command immediately initializes the external signal generator with
the settings configured in the R&S FSV-K30 option (reference, power level , etc.). It
also switches the external generator's RF output on. This has to be done before a
measurement using the external generator control can be run if any of the external
generator settings have changed, unless the auto-initialisation feature is enabled (see
SYSTem: ​CONFigure: ​GENerator: ​INITialise: ​AUTO ​ on page 123).

Example: SYST:CONF:GEN:INIT:IMM
The R&S FSV-K30 option initialises the selected signal genera-
tor.

Usage: Event

Mode: NF

Manual operation: See "Init Generator" on page 69

SYSTem:CONFigure:GENerator:INITialise:AUTO <State>

This remote control command specifies whether an initialisation sequence of GPIB
commands is sent to an external signal generator prior to performing each measure-
ment. Sending an initialisation sequence before each measurement ensures that the
signal generator is in the correct state to receive control commands during a measure-
ment sequence. On the other hand, initialising an external signal generator before
each measurement adds a time overhead to each measurement.

Parameters:
<State> ON | OFF

ON
The R&S FSV-K30 option initialises the selected signal genera-
tor prior to starting each requested measurement.
OFF
No initialization is performed.
*RST: OFF

Example: SYST:CONF:GEN:INIT:AUTO ON
The R&S FSV-K30 option initialises the selected signal genera-
tor prior to starting each requested measurement.

Mode: NF

Manual operation: See "Init Before Meas" on page 54

SYSTem:CONFigure:GENerator:SWITch:AUTO <State>

This remote control command specifies whether a sequence of GPIB commands is
sent to an external signal generator at the end of each measurement (after a single
sweep or after a measurement is aborted) to switch the generator's RF output off and
end remote control.

SYSTem Subsystem (Noise Figure, R&S FSV-K30)
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Parameters:
<State> ON | OFF

ON
The generator's RF output is switched OFF after each measure-
ment and remote control is ended.
OFF
The generator's RF output is NOT switched off after each mea-
surement; remote control remains active.
*RST: OFF

Example: SYST:CONF:GEN:SWIT:AUTO ON
The R&S FSV-K30 option switches the generator's RF output
OFF after each measurement and ends remote control.

Usage: Event

Mode: NF

Manual operation: See "Auto Switch Off" on page 54

SYSTem Subsystem (Noise Figure, R&S FSV-K30)
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9 Error Reporting and Error Messages
Error reporting for the Noise Figure Measurements option is carried out using the Ser-
vice Request (SRQ) interrupt in the GPIB interface. When an error occurs a Service
Request interrupt will be generated. The master can then query the slave instrument
for the error that triggered the interrupt Errors are queried through the "SYS-
Tem:ERRor'' command.

Status bar message Description

Frequency list truncated, max 100 entries The settings for start, stop and step frequencies
would require a frequency list greater than 100
entries. The list calculated is terminated at the 100th
entry. Try using a larger step size of splitting the test
up into a series of frequency list tests.

Missing [ENR][,|&][LossIn][,|&][LossOut] for
meas.freq.

No ENR, loss input and/or loss output can be deter-
mined for one or all of the measurement frequen-
cies. This occurs when using tables of ENR, loss
input and/or loss output values. Check that the fre-
quency ranges of the tables covers the range of fre-
quencies to be measured. For each measurement
frequency, where ENR, loss input or loss output
cannot be determined, 0 is used.

Generator connection error No connection could be made to the external signal
generator (with option R&S FSV-B10 only). Check
the connection between the analyzer and the signal
generator. Also check that the correct GPIB address
has been specified for the signal generator.

Generator not initialised The external signal generator has not been initial-
ized and as such cannot be controlled by the spec-
trum analyzer (with option R&S FSV-B10 only).The
signal generator can be initialized manually by
pressing the "INIT GEN" softkey in the "Input/
Output" menu, or can automatically be initialized by
selecting the "Init before meas" field in the "Mea-
surement Settings".

Generator frequency out of range The LO frequency to be used for a measurement
point is out of range for the selected signal genera-
tor (with option R&S FSV-B10 only). Reduce the LO
frequency or use a signal generator with the
required frequency range.
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List of Commands
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